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Safety Guidelines

This manual contains notices intended to ensure personal safety, as well as to protect the products and
connected equipment against damage. These notices are highlighted by the symbols shown below and
graded according to severity by the following texts:

Danger

/N

are not taken.

indicates that death, severe personal injury or substantial property damage will result if proper precautions

Warning

/N

precautions are not taken.

indicates that death, severe personal injury or substantial property damage can result if proper

Caution

>

indicates that minor personal injury can result if proper precautions are not taken.

Caution

indicates that property damage can result if proper precautions are not taken.

Notice

draws your attention to particularly important information on the product, handling the product, or to a

particular part of the documentation.

Qualified Personnel

Repair, maintenance and servicing of device only to be carried out by qualified personnel. Qualified
persons are defined as persons who are authorized to commission, to ground and to tag circuits,
equipment, and systems in accordance with established safety practices and standards.

Correct Usage

Warning

Note the following:

This device and its components may only be used for the applications described in the catalog or the

technical description, and only in connection with devices or components from other manufacturers which
have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed
correctly, and operated and maintained as recommended.

Trademarks

SIMATICO, SIMATIC HMIO and SIMATIC NETO are registered trademarks of SIEMENS AG.

Third parties using for their own purposes any other names in this document which refer to trademarks

Copyright © Siemens AG 2002 All rights reserved

The reproduction, transmission or use of this document or its
contents is not permitted without express written authority.
Offenders will be liable for damages. All rights, including rights
created by patent grant or registration of a utility model or
design, are reserved.

Siemens AG

Bereich Automation and Drives
Geschaeftsgebiet Industrial Automation Systems
Postfach 4848, D- 90327 Nuernberg

Disclaim of Liability

We have checked the contents of this manual for agreement
with the hardware and software described. Since deviations
cannot be precluded entirely, we cannot guarantee full
agreement. However, the data in this manual are reviewed
regularly and any necessary corrections included in
subsequent editions. Suggestions for improvement are

O Siemens AG 2002
Technical data subject to change.

Siemens Aktiengesellschaft
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welcomed.
Excellence in
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Siemens



Preface

Purpose of the Manual

This manual contains all the information you need for commissioning and using the
SIMATIC Power PG programming device.

It is intended both for programming and testing/debugging personnel who
commission the device itself and connect it with other units (automation systems,
further programming devices) as well as for service and maintenance personnel
who install expansions or carry out fault/error analyses.

Where is this Manual Valid?

This manual is valid for all supplied variations of the SIMATIC Power PG and
describes the state of delivery in January 2002.

Certifications, Standards and Approvals
Certifications
The device fulfils the following guidelines and certifications:
» EU guideline 73/23/EEC on low voltages
» EU guideline 89/336/EEC on electromagnetic compatibility
» Underwriters Laboratories (UL) to Standard UL 1950
» Canadian Standard Association (CSA) to Standard C22.2 No. 950
Standards and Approvals

The device fulfils the requirements for the CE approval. Approvals for UL and CSA
are available.

Further information on the approvals, certificates, and licenses for your device is
provided in Chapter 1.

Incorporation into the Communications Environment
This manual forms part of the supplied CD “Backup PG”.

For supplementary instructions on how to handle the software please refer to the
corresponding manuals (for example, the STEP 7 Manual).

SIMATIC Power PG Manual
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Structure of the Manual

Chapters |1 to 5 of the manual contain the most important instructions for
commissioning and using the SIMATIC Power PG. Chapters |6 tg 8 are reference
sections required in special situations.

Important Notes

Chapter |1 contains information on security, certificates, guidelines and
approbations.

Getting Started
Chapter|2|describes the components of the Power PG and its functions.
Configuration and Operation

Chapter|3 describes the basic steps necessary for commissioning the Power PG.
This chapter also contains instructions for working with submodules and memory
cards for programmable logic controllers and additional interfaces.

Expansion

Chapter/4/describes how to expand your Power PG (for example, installation of
memory expansions). Please observe the safety instructions in this section.

Configuration

Modifications made to the system hardware may make it necessary for you to
adapt the original hardware configuration. This is described in Chapter|5.

Error/fault diagnostics

Chapter|6/explains how to deal with simple faults and problems that you can
diagnose and, in some cases, eliminate yourself.

Hardware Information

Chapter 7|contains information about the system resources and the connecting
cables.

Reinstalling the Software
Should you need to reinstall the software you can find the procedures in Chapter|8.
ESD guidelines

The guidelines on the handling of electrostatic-sensitive devices in Appendix A are
particularly important for service and maintenance technicians who are installing
expansion units or carrying out error analysis with the PG.

Technical Specifications
Appendix B contains the valid technical specifications for your device.
Glossary

The glossary defines and explains important terms.

SIMATIC Power PG Manual
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Alphabetical index

The alphabetical index will help you to find passages in the text relating to
important terms and keywords quickly and reliably.

Conventions

The abbreviation PG oder device is also used within this manual for the product
designation SIMATIC Power PG.

Further Support

If you have questions related to the use of the SIMATIC Power PG which are not
answered in this manual, please consult your Siemens representative in your local
agency. You will also find your representatives for repairs and spare parts at

http://www.ad.siemens.de/partner

Training Center

Siemens offers a number of training courses to familiarize you with the SIMATIC
S7 automation system. Please contact your regional training center or our central
training center in D 90327 Nuremberg, Germany for details:

Telephone: +49 (911) 895-3200

http://www.sitrain.com/

SIMATIC Documentation on the Internet
You will find the documentation on the internet at:
http://www.ad.siemens.de/support

Use the Knowledge Manager to find the documentation you need quickly. If you
have any questions or suggestions concerning the documentation you can use the
"Documentation” conference in the internet forum.

SIMATIC Power PG Manual
A5E00097462-02 \
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Automation an Drives, Service & Support

Available worldwide, around the clock:

Worldwide (Nuremberg)
Technical Support

(Free Contact)

Local time: Mo.—Fr. 7:00 to 17:00
Phone: +49 (180) 5050 222
Fax: +49 (180) 5050 223

E-mail: techsupport@
ad.siemens.de

GMT: +1:00
Europe / Africa (Nuremberg)
Authorization

Local time: Mo.—Fr. 7:00 to 17:00
Phone: +49 (911) 895-7200
Fax: +49 (911) 895-7201

E-mail: authorization@
nbgm.siemens.de

GMT: +1:00

5 G
L Ql’%n.. e
o Singapore
i

SIMATIC Basic Hotline

Worldwide (Nuremberg)
Technical Support

(charged, only with
SIMATIC Card)

Local time: Mo.—Fr. 0:00 to 24:00
Phone: +49 (911) 895-7777
Fax: +49 (911) 895-7001
GMT: +01:00

America (Johnson City)

Technical Support and
Authorization

Asia / Australia (Singapore)
Technical Support and
Authorization

Local time: Mo.—Fr. 8:00 to 19:00 Local time: Mo.—Fr. 8:30 to 17:30

Phone: +1 423 461-2522 Phone: +65 740-7000

Fax: +1 423 461-2289 Fax: +65 740-7001

E-mail:  simatic.hotline@ E-mail:  simatic.hotline@
sea.siemens.com sae.siemens.com.sg

GMT: -5:00 GMT: +8:00

German and English are spoken on all the SIMATIC hotlines, French, Italian and Spanish are also spoken on the

authorization hotline.

Vi

SIMATIC Power PG Manual
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Service & Support on the Internet
In addition to our documentation, we offer our Know-how online on the internet at:

http://www.ad.siemens.de/support

where you will find the following:

» Current Product Information leaflets, FAQs (Frequently Asked Questions),
Downloads, Tips and Tricks.

* A newsletter giving you the most up-to-date information on our products.
» The Knowledge Manager helps you find the documents you need.
» Users and specialists from all over the world share information in the forum.

* Your local customer service representative for Automation & Drives in our
customer service representative data bank.

» Information on field service, repairs, spare parts and more under "Services”.

SIMATIC Power PG Manual .
A5E00097462-02 Vil
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Important Notes 1

1.1 Safety Instructions

ii Caution
The safety instructions given on the second page of this manual must be obser-
ved. Before adding to the Power PG'’s functionality by expanding the hardware
configuration (see Chapter 4) observe the relevant safety instructions.

Notes on Inserting and Removing Modules

Modules containing electrostatically sensitive devices (ESDs) can be identified by
the following label:

Please observe and carefully follow the guidelines mentioned below when handling
modules equipped with electrostatically sensitive devices:

Always discharge your body’s static electricity before handling modules
equipped with ESDs (for example by touching a grounded object).

Devices and tools must be free of static electricity.

Always pull the power plug and disconnect the battery before connecting or
disconnecting modules (containing ESDS).

Touch modules fitted with ESDs by their edges only.

Never touch wiring posts or printed conductors on modules (containg ESDs).

SIMATIC Power PG Manual
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Important Notes

1.2 Certificates, Directives and Declarations

Notes on the CE Symbol

ce The following applies to the SIMATIC product described in this operating
instruction:

EMC Directive

This product fulfils the requirements for the EC directive 89/336/EEC on
“electromagnetic compatibility” and the following fields of application apply
according to this CE symbol:

Field of Application Requirement for
Emitted Interference Noise Immunity
Residential and commercial areas and EN 50081-1: 1992 EN 50082-1: 1992
small businesses.
Industry EN 50081-2: 1993 EN 50082-2: 1995

The product is also compliant with the Standards EN 61000-3-2:1995 (Harmonic
currents) and EN 61000-3-3:1995 (Voltage fluctuation and flicker).

Low Voltage Directive

This product fulfils the requirements for the EC directive 73/23/EEC on
“low voltage” and was tested to EN60950.

Declaration of Conformity

The EC declarations of conformity and the documentation relating to this are
available to the authorities concerned, according to the above EC directive, from:

Siemens AG

Bereich Automation & Drives

A&D AS RD4

Postfach 1963

D-92209 Amberg

Tel.: 09621 80 3283

Fax: 09621 80 3278

Observing the Setup Guidelines

The setup guidelines and notes on safety given in the manual must be observed
on startup and during operation.

SIMATIC Power PG Manual
1-2 A5E00097462-02



Important Notes

Connecting Peripheral Devices

Noise immunity when connected to industrial standard peripheral devices conforms
with the requirements of EN 500082-2.

ISO 9001 Certificate

The quality assurance system for the whole product process (development,
production, and marketing) fulfills the requirements of ISO 9001 (corresponds to
EN29001: 1987).

This has been certified by the German society for the certification of quality
management systems (DQS).

EQ-Net certificate no.: 1323-01

Software License Agreement

The PG is shipped with the software already installed. Please observe the relevant
license agreements.

1.3 Certification for the USA, Canada and Australia

Security

One of the following markings on a device is indicative of the corresponding
approval:

Underwriters Laboratories (UL) to the UL 1950 standard.

Canadian Standard Association (CSA) to Standard C22.2. No. 950

SIMATIC Power PG Manual
A5E00097462-02 1-3
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EMC

USA

Canada

Australia

1-4

C

Federal Communications Commission
Radio Frequency Interference Statement

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Shielded Cables

Shielded cables must be used with this equipment to maintain compliance with
FCC regulations.

Modifications

Changes or modifications not expressly approved by the manufacturer could void the
user’s authority to operate the equipment.

Conditions of Operations

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Canadian Notice

This Class B digital apparatus complies with Canadian ICES-003.

Avis Canadien

Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

This product meets the requirements of the AS/NZS 3548 Standard.

SIMATIC Power PG Manual
A5E00097462-02
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1.4

Cleaning

Cleaning and Transporting the Power PG

To prolong the lifetime of your Power PG and use it free of trouble, do not expose it
without cause to dust nor use aggressive cleaning agents to clean it.

* You can clean the display and the keyboard with customary screen cleaning
tissues.

» The other case parts can be cleaned with a common household detergent.

Caution

Never spray cleaning liquids directly onto the device and prevent ingress of liquid.

Transportation

Despite of the rugged structure of the Power PG, its installed components are
sensitive against severe vibration and impact. You can contribute to trouble-free
operation by taking a few precautions for the transportation.

» Ensure that the computer does not access anymore drives before you prepare
it for transportation.

» Remove all floppy disks or CD-ROMs from the respective drive.

» Switch off the PG (refer to Chapter|2.5).

» Disconnect all external devices from your PG.

» Close the display and the cover on the left-hand side of the device.
» Close the device by inserting the keyboard and folding it up.

» Use the handle for short transports.

» Pack the Power PG and all accessories into the supplied transport case if you
are going to transport it over greater distances.

You should use the original package for the shipment of the programming device.

SIMATIC Power PG Manual
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Getting Familiarized with the SIMATIC

Power PG

What do you find in this Chapter?

2

This chapter briefly presents the most important components of the SIMATIC
Power PG. Get familiarized with these elements before you start to commission

the PG.

Chapter Overview

Section Description Page
21 Components of the SIMATIC Power PG 2-2
2.2 Keyboard 2-9
23 Touchpad 2-16
2.4 LED displays 2-17
25 On/Off Pushbutton (Power Button) 2-18
2.6 Drives 2-20
2.7 External Power Supply and Battery 2-24

SIMATIC Power PG Manual
A5E00097462-02

2-1




Getting Familiarized with the SIMATIC Power PG

2.1

Components of the SIMATIC Power PG

View with closed display

2-2

SDEMENST

-
iﬂjﬂ

1 Unit Handle
Swing—out handle.

2 Keyboard placed in front
The keyboard can be removed and serves as a display cover in a closed state.

3 Adjustment feet of the keyboard

The angle of the keyboard can be adjusted by folding out its adjustment field. This
ensures that the ergonomic requirements for ideal working consitions are fulfilled
4 Adhesive surfaces for keyboard identifier

The supplied labels with the identifier of the corresponding keyboard can be
applied to these adhesive surfaces.

5 Receiver unit for keyboard signals

The receiver unit contains the keyboard transmission LED and the infrared receiver
for the keyboard signals.

6 LED for keyboard transmission status

Green flashing Keyboard is transferring data.

Red flashing  Faulty data transmission from the keyboard.

Red Battery in the keyboard is discharged.

SIMATIC Power PG Manual
A5E00097462-02



Getting Familiarized with the SIMATIC Power PG

Notice

If the receipt is poor, correct the position of the keyboard to the unit.

If the LED displays the status “Battery discharged”, the batteries in the keyboard
have to be replaced. A battery set lasts several months.

The keyboard can be supplied via the USB cable if necessary.

In order to differentiate between various keyboards the keyboard can be assigned
to the basic unit. As long as the keyboard does not have an ID, the device outputs

a message after startup. The procedure is described in Chapter|2 of the electronic
manual.

Front View of the unit Ready-to-operate
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1 Adjustable display

The Power PG has a 5” TFT display with a resolution of 1024 x 768 pixels. When

the keyboard of the basic unit has been removed, the angle of inclanation of the
display can be adjusted.

SIMATIC Power PG Manual
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Getting Familiarized with the SIMATIC Power PG

2-4

2 Stereo loudspeaker

The speaker outputs audio and system alarm signals generated by the software.
Loudness is adjusted via speaker icon in the task bar or in the Windows Start
menu via Programs > Accessories > Multimedia > Loudness

3 Keyboard

The keyboard consists of 3 key areas: The alphanumeric keyboard field with
special keys, the function keys, the numerical keyboard field with the control keys.
4 Mouse buttons

You can use the left or right mouse button to select menu items or process text or
graphic objects after having marked the respective object.

5 Touchpad

The Touchpad has a pressure sensitive surface for precise mouse pointer
positioning.

6 Keyboard interlock

The keyboard is connected to the base unit with two locks. The slide interlock is
mounted at the side of the keyboard.

7 Additional send window for infrared signals of the keyboard

An additional send window ensures improved transmission of the infrared signals.

8 Battery compartment
The battery compartment contains 4 Mignon cells of type AA, LR6 or AM3.

9 Send window for infrarot signals of the keyboard

The infrared sender transmits the keyboard signals to the unit. The send window is
provided with areas for the keyboard ID stickers.

10 Certificate of Authenticity

“Certificate of Authenticity” with the Microsoft Windows “Product Key”. You need
this to install new software.

11 Keyboard LEDs

The keyboard LEDs display the current status of the shift keys Num Lock ,

Caps Lock and Scroll Lock . When the unit is powered up, the displays of
these keys are actuated briefly. The keyboard Is ready for operation.

12 Infrared receiver for the keyboard

The infrared receiver can be used to receive keyboard signals.

13 On/Off-button (Power Button)

Use the On/Off pushbutton to power up the Power PG (into active state) or to
switch it from active to inactive state (Off or Hibernate). The Power Button can be
parameterized under Windows. The Windows NT versions do not support this
power management.

SIMATIC Power PG Manual
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Getting Familiarized with the SIMATIC Power PG

14 System-LEDs

The system LEDs (unit , drives 8 , MPI/DP MPI/DP and Memory Card ﬂ:l )
indicate the operate state of the rechargeable battery, unit, drives, MPI/DP and
Memory Card interface.

The drive access displays are arranged on the right hand side of the corresponding
drives.

Left—-hand Side View

The connector shaft is positioned behind a hinged door.

1 VGA
You can connect an appropriate external monitor to this connector.

Caution

Ensure the monitor can handle the resolution and refresh rate settings. Otherwise, it can
result in damage.

2 PC-Card slots

The PC-Card slots can be used for Cardbus (32 Bit) and PCMCIA (16 bit) cards.
You can insert card-size communication modules for MODEM, FAX-MODEM,
ISDN, Token Ring, ETHERNET, memory expansions and SCSI interfaces.
CardBus Cards are not supported by Windows NT. Refer to Chapter 3.9 of the
electronic manual.

SIMATIC Power PG Manual
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Getting Familiarized with the SIMATIC Power PG

3 usB * ="

Universal Serial Bus connector. You can use the USB port to connect external
units, for example, CD drives, printers, modems as well as a mouse and keyboard.
The Windows NT versions only support mouse and keyboard.

==
4 Ethernet E

RJ45 Ethernet connector. Ethernet is a local area network with a bus structure for
data communication with a data transfer rate of 10 or 100 megabit per second
(Mbps).

5 MPI/DP Multipoint Interface

The MPI/DP interface is isolated from line potential. You can use it to connect the
SIMATIC Power PG to an S7 automation system or to a PROFIBUS network.

6 com1 v.24 /mopem/aG |OIO|

The COM 1(TTY) interface is used to connect, for example, S5 automation units
(AG). The supplied adapter “Serial Port Adaptors D9/D25” can be used to convert
the interface into a 9-pole standard V.24 interface for connecting serial interface
devices such as a modem, mouse or printer. Refer to Chapter 3.10|of the
electronic manual.

7 Inlet connector for non-heating apparatus

The Power PG can be operated at 120V and 230V circuits. The transition is carried
automatically.

8 SIMATIC Memory Card interfaceﬂ:I

This interface can be used to read, program or delete SIMATIC Memory Cards for
SIMATIC S5 and SIMATIC S7. The supplied S5 adapter can also be used to
program or read out SIMATIC S5 EPROM modules.

9 LPT1/Printer

The parallel port connection for devices with parallel port (e.g. printer)

10 Expansion slots

The expansion slots are covered by blanking covers. The mounting shaft is
covered by a sliding door.

SIMATIC Power PG Manual
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Getting Familiarized with the SIMATIC Power PG

Right-hand Side View

i
1
2
8 —
7
6 3
—+H )
1
1 0 =
5
1 Protectors
These are used to protect the corners of the unit.
2 Air venting slots
Here is the ventiduct.
Caution
The ventiducts for outgoing air must not be obstructed. Otherwise, there is a risk of overhea-

ting.

3 Floppy disk drive

Depending on the device configuration, a standard floppy disk drive (1,44 MB), a
Superdisk LS120 or a Superdisk LS240 drive is built in. 3.5” diskettes (of 1.44 MB)
and Superdisks (up to 120 MB) can be used with the LS120 drive. For LS240,
additional Superdisks up to 240 MB are required.

4 Optical drive

Depending on the device configuration, it can come with a CD-ROM, a DVD-ROM
ora DVD-ROM/CD-RW drive. For example, you can read the electronic manual of
the supplied "Backup PG” CD with this drive.

SIMATIC Power PG Manual
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Getting Familiarized with the SIMATIC Power PG

5 Opening for the Kensington lock

A security cable with a lock is connected to this opening. You can use it to protect

your PG against theft by locking the cable to the writing desk or any heavy
appliance.

6 SIMATIC Micro Memory Card interface Cl

This interface can be used to read, program or delete Micro Memory Cards.

N
7 Microphone /)

You can connect an external microphone or another audio output device to this
microphone jack.

8 Headphones Q

You can connect an external stereo headphone or another audio output device to

this headphone jack. The internal speaker is automatically disabled when a
headphone is connected.

Bottom View
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1 Air venting slots
Here is the ventiduct.

Caution

The ventiducts for incoming and outgoing air must not be obstructed. Otherwise, there is a
risk of overheating.

2 Rating plate

The rating plate displays the identification data of your data, e.g. the manufacturing
number.
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2.2

Keyboard

The cordless infrared keyboard of the Power PG has an integrated Touchpad. The
signal transmission is carried out unidirectionally via infrared signals.
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1 Openings for the latches
The latches at the basic unit fit into these openings in and lock the keyboard.

2 Mouse buttons

You can use the left or right mouse button to select menu items or process text or
graphic objects after having marked the respective object.

3 Touchpad

The Touchpad has a pressure sensitive surface for precise mouse pointer
positioning.

4 Alphanumeric keyboard

The largest block of keys on the keyboard is the alphanumeric keyboard with all
the keys for the letters of the alphabet, numerals and special characters. The
characters are arranged in basically the same way as on a normal typewriter.
However, there are a number of special keys which have special functions for the
PG.

A row with twelve programmable Function Keys is located above the alphanumeric
keyboard. The individual function of these keys depends on the software you are
working with.

5 Numeric keyboard

The numeric keyboard is divided into two function groups: The numeric block and
the cursor control keys.

SIMATIC Power PG Manual
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6 Guide pins
If you want to lock the keyboard to the basic unit, you first have to insert the guide
pins of the keyboards into the openings provided in the basic unit.

7 Areas for ID stickers
Stick the supplied ID stickers with the chosen ID onto these areas.

8 Send window for infrared signals

Infrared signals from the keyboard to the receiver unit or to a further infrared
receiver are sent from these send windows.

9 Battery compartment

The battery compartment contains 4 Mignon cells of the type AA, LR6 or AM3. The
battery set has to be replaced when the LED in the keyboard receiver unit rot
displays red. A battery set lasts several months depending on the actual operation.

10 Connector for the USB cable

When the batteries are discharged power can be supplied to the keyboard via the
supplied USB cable. The USB cable is connected via this connector to the USB
connection on the unit.

Notice

The USB cable is only used to supply power to the keyboard. Data traffic does not
take place via this cable.

Repeat Function

All the keys on the keyboard are of the autorepeat type. The character is repeated
as long as the key is pressed.

Keyboard Caps

The keyboard comes with international and German labeling.

International National
Shift — | ?
) _ \ Together with
Unshift B ALTGR key

Fig. 2-1 The Keyboard Labeling System
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Special Keys

The special keys in the alphanumeric keyboard have the following functions:

Key

Function

Backspace key

This key moves the cursor one space to the left and deletes the character at
this position.

Enter Key
(Return, Enter, Line Feed (“New Line”")

The return or enter key is used mainly to terminate a command line in the
operating system; that is, the command you have entered is executed when
you press this key. For other uses of this key, please refer to the user ma-
nual of the relevant user program.

CAPS LOCK Key

If you press this key, the middle LED at the top right-hand corner of your
keyboard lights up. All upper case characters and other characters are out-
put normally. If you want to type lower case letters in this position, you must
first press the shift key.

If you are using an international keyboard, you cancel this function by pres-
sing the CAPS LOCK key again. The LED then goes out.

If you have a German keyboard, you must press the shift $ key to cancel
this function.

NUM Key

This key toggles the numeric block (Fig. 2—3) from the numeric keyboard to
cursor control keyboard function. The LED display lights up. Pressing this
key again reverses this function.

Scroll-Lock-Taste

Monitor scrolling is either enabled or disabled with this key.

Tab Key

This moves the cursor depending on the selected tabulator positions.

“Fn” Special Key (combination key)

In conjunction with a second key (key combination), you activate other key
codes for special applications with this key.

CTRL Key (combination key)

This key is only used in combination with other keys. For example, you
press CTRL + ALT + Delete to reset and restart the operating system. For
other uses of this key, please refer to the user manual of the relevant user
program.

SIMATIC Power PG Manual
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Function

Key

ALT Key (combination key)

This key is only used in combination with other keys. For example, you can
enter the hexadecimal value of an ASCII character (and thus additional spe-
cial characters) by using this key and the numeric keypad (ALT + ASCII va-
lue while the NUM key is active, for example, ALT + 132 corresponds to “&@”.

ALT & Key (combination key)

You can use this key together with the other combination keys to generate
other key codes. For example, you can generate the “\" character on the
German keyboard by typing ALTg, + 3.

PRINT (combination key)
Using the Print key, you can output the current screen display to a printer
(depending on the software used).

PAUSE (combination key)

The Pause key interrupts program execution in the majority of applications.

Cursor Keys

The key block shown in the picture below is used for cursor control. Home and End
are operated in combination with the Fn key.

e ... -

Page back
Cursor up

Move cursor to beginning of file

Page forward
Move cursor to end of file

Cursor down

Fig. 2-2

2-12

Cursor Keys
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Numeric Keypad

The Num Lock-key toggles the numeric block from the cursor control keys to
numerical keys. The LED is displayed. Pressing this key again reverses this

function.
7 8
Home ¢ PgUp

Fig. 2-3 Numeric Keypad
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221

Assignment of a Keyboard to the Corresponding Power PG

In order for every Power PG to recognize the keyboard assigned to it, an identifier
has to be assigned specifically to it. This is the only method of ensuring that the
cordless keyboards do not interfere with each other when there are several Power
PGs in a room. Up to 10 different identifiers can be differentiated.

Note

In order to have the identifiers available apply the labels with the selected identi-
fiers on the surfaces provided on the unit and the keyboard. This makes it easy to
recognize which keyboard belongs to which unit.

Assigning a New Keyboard Identifier

In the factory setting, your device uses 0 as its specific keyboard ID. A message
(ERROR) on your screen however means no specific keyboard ID was given; you
are the prompted to enter a keyboard ID

» If you now respond with F1 to this message, the unit continues to operate
without a specific keyboard identifier and all the keyboards can act on the unit.

» If you respond with F2 to this message, the system starts the BIOS Setup.
Proceed as follows:

1. Select one of the offered IDs in the menu Main > Keyboard Features >
Keyboard ID: .

2. Open the keyboard ID menu with the enter key and select a “Num ID” (ID = 0-9)
with the cursor keys.

3. After selecting, it is necessary to synchronize the keybord via the key
combination Fn + ALT + ID (ID = 0-9 of the numeric keyboard area).

Example (setting the Num ID to 5):

Select the menu Main > Keyboard Features > Keyboard ID:  in the BIOS setup.
Use the enter key, then the cursor keys to select the Num ID 5 and acknowledge

with the enter key. Synchronize the keyboard with the PG via the key combination
Fn+Alt+5 ..

Assigning a Keyboard Identifier during Operation

2-14

A keyboard can also be synchronized with the unit during operation. To this
purpose the key combination Fn + ALT + ID has to be pressed. The keyboard is
then set to the selected identifier. The three keyboard LEDs Num-Lock, Caps-Lock
and Scroll-Lock light up briefly in order to confirm that the selected identifier agrees
with the set identifier in the unit.
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Searching for the Keyboard Identifier in the Unit

To search for a forgotten identifier, try out all the possible identifiers on the
keyboard. The three keyboard LEDs at the top of the display light up briefly when
the correct identifier has been found at the unit. Then, the unit and the keyboard
are synchronized again

Notice

Data transfer to the unit is only possible if the keyboard ID agrees with the ID in
the unit.
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2.3

Definition

Operation

2-16

Touchpad

The Touchpad is an input device for cursor control and menu operation (with
mouse operation) in numerous programs. You can move the cursor to any screen
position by touch.

A left button click on sets the mark. The right button assignment varies, depending
on the user program. You can select objects, process menus or trigger functions
with this Touchpad.

You can use the Touchpad the very same way as a mouse: the mouse pointer on
the screen follows the movement of your finger on the pad.

You can click on icons or text with both mouse buttons. First, move the mouse
pointer onto the icon. Then, select the icon with a left click.

As an alternative, in a fully graphical user interface, for example, the Windows
GUI, you can mark an icon and then move the mouse pointer on top of it. You can
then open the icon with a double tap on the Touchpad.

You do not have to apply any pressure on the pad with your finger. The sensor
does not react to finger pressure, but rather to the brief capacitance change on the
touch point.

SIMATIC Power PG Manual
A5E00097462-02



Getting Familiarized with the SIMATIC Power PG

2.4 LED displays

Keyboard LEDs

The LED displays for the Num-Lock, Shift-Lock and Scroll-Lock keys are
positioned above the display. They indicate the current status of the shift keys.

Meaning of the keyboard LEDs

Symbol LED Meaning
/) green Num-Lockon
off Num-Lock off
= green Shift-Lock on
off Shift-Lock off
~ green Scroll-Lock on
off Scroll-Lock off

System LEDs

The system LEDs (battery, unit, drives, MPI/DP and Memory Card) indicate the
status of the battery pack, the unit, the drives as well as the MPI/DP and Memory
Card interfaces. These LEDs are also visible when the display is closed.

Meaning of the System LEDs

Symbol LED Meaning
green Line operation
off Unit is switched off
On
green Access to external storage media (hard disk drive,
Ej optical drive, floppy disk drive)
MPI/DP green MPI interface active
green Module programming, Memory Card or
[ Micro Memory Card active

Meaning of the LED for the Keyboard Status

The LED is positioned in the receiver unit of the unit.

Green flashing | Keyboard is transmitting valid data
Red flashing Keyboard is transferring faulty data
Red Battery in the keyboard is discharged and has to be replaced

SIMATIC Power PG Manual
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2.5

On/Off Pushbutton (Power Button)

Switching the Power PG On

The on/off pushbutton, also called the Power button, is positioned at the top of the
display housing. The unit is switched on when this pushbutton is kept pressed for
approximately 1 second.

Switching the Power PG Off

The Power PG can be toggled from normal mode to one of the following modes by
using the On-/Off-pushbutton or by selecting the respective Windows Start menu:

» Hibernate (Save to Disk),
» Off (Windows is shut down).

If operated under a Windows OS the unit is switched off automatically when you
shut it down. If not operated under Windows you can switch the unit off via On-/Off
pushbutton.

Notice

The Windows NT versions do not support the hibernate operating mode. After shut
down the Power PG always has to be switched off via the Power Button.

Hold down the On-/Off pushbutton for more than 7 seconds to trigger the
“Override” function. The unit is switched off.

Note

Via Setup > Control Panel > Power Management under Windows Me and
Windows 2000 you can parameterize the reaction of the On-/Off-pushbutton.

To isolate the unit totally from the power supply system, you must unplug the patch
cord.

Energy Options

2-18

You can optimize the energy consumption of your PG using the energy options
while maintaining the PG in operate state.

In Hybernate mode the screen and hard disk drive are switched off. All data in
memory is stored to the hard disk drive before the PG is switched off. When you
switch on your PG again, all programs and documents that were opened at the
time of shut-down are restored to the desktop. Hybernate mode relieves the
battery pack even more than Standby mode. However, it requires a longer time to
reactivate the PG from this hybernating state.
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Note

Select this setting if you want to interrupt your work over an extended period
(several hours) or over night.

Briefly push the On/Off button to reactivate the PG from hybernate mode.
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2.6 Drives

2.6.1 Floppy Disk Drive

Depending on the device configuration, a standard floppy disk drive (1,44 MB), a
Superdisk LS120 or a Superdisk LS240 drive is built in. 3.5” diskettes (of 1.44 MB)
and Superdisks (up to 120 MB) can be used with the LS120 drive. For LS240,
additional Superdisks up to 240 MB are required.

Types of Diskette

You can use the following diskettes:

Standard LS120 LS240
Floppy Disk Drive

3.5inch v v v
1.44 Mbytes (135 TPI)

3.5inch - v v
120 Mbytes

3.5inch - - v
240 Mbytes

Handling Diskettes

When the diskette drive is accessed, the access display at the drive and the

System LED 8 above the display lights up.

Caution
Risk of data loss!

Do not remove diskette until the access indicator on the drive has been switched
off.

Emergency Removal bei LS120/LS240 Disk Drive

When the device is switched off, the disk can be forced out by using a pin
(for example, a bent paper clip).
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Information on the LS120/LS240 Disk Drive

Restrictions
P-Tools under STEP 5

Data cannot be edited in PCP/M format on the LS120/LS240 drive using P Tools
under STEP 5.

Notice

When you use the P Tools (for editing PCP/M files) supplied with STEP 5,
remember that these are not fully supported by the Windows Me and

Windows 2000 operating systems nor by LS120/LS240 diskette drives. If you use
the P Tools, we recommend that you use MS-DOS, Windows 3.x or Windows 95
and standard 1.44 Mbyte floppies.

Authorization with Authors W V2.x

To authorize STEP 7 and other SIMATIC components you must use AuthorsW.
Start this program on the PG via the taskbar under Start > Simatic > AuthorsW.

Usage Notes for LS120/LS240 Superdisks
The LS120/LS240 drive automatically recognizes the different floppy disk types.

Due to their higher storage capacity, Superdisks are more sensitive to dirt,
temperature and shock than conventional disks.

Notice

In order to achieve a reliable operation and high data security, please note the
following during use:

» Store and transport the Superdisk in the protective cassette included to keep
dust and dirt from the disk.

» Remove Superdisk from the drive when it is not being read or written to keep
dirt particles away from the disk. Do not expose the disk unnecessarily to high
operating temperatures.

Notice

If possible avoid vibration of the unit, when using Superdisks. Superdisks are more
sensitive to vibration as a result of their high track density.
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2.6.2 Hard Disk Drive

A variety of hard disk drives can be operated with the SIMATIC Power PG.

Whenever the hard disk is accessed, the system LED 8 above the display
lights up.

Caution

Drives are sensitive to vibrations and shock. Any vibrations occurring during ope-
ration can result in loss of data or damage the drive.

2.6.3 Optical Drive

Depending on the device configuration, it can come with a CD-ROM, a DVD-ROM
or a DVD-ROM/CD-RW drive. For example, you can read the electronic manual of
the supplied "Backup PG” CD with this drive.

Opening the Drawer

Switch on the programming device. By briefly pressing the eject button, the drawer
springs out slightly. Now pull the drawer out until it clicks into position.

Inserting / Removing CDs

Now insert the CD in the drawer with the labeling facing forwards, and press it
firmly down into the center of the turntable. To remove the CD, hold it by the edges
and pull upwards.

Closing the Drawer

Push in the drawer until it closes completely. Do not press the eject button.

Emergency removal

By pushing a pin into the emergency release opening (for example, a paper clip)
while the device is switched off, you can force the drawer to open.
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Notice

To ensure that the open drawer of the CD-ROM drive is not exposed to excessive
force, always support the front of the drawer with one hand while inserting or re-
moving the CD-ROM with the other.

The CD is tested when you close the drive and the access LED on the drive flas-
hes to indicate that the test is in progress:

— if the LED does not stop flashing the CD is bad but readable,

— if the LED flashes several times and then remains on, the CD is not readable and
defective.

Caution
Risk of data loss and damage to the drive.

Optical drives are sensitive to shocks. During operation shocks can cause da-
mage to the drive or to the data medium.

Use the DVD-ROM/CD-ROM drive for a burning operation in untroubled
environment only.

Additional Software

To be attain the full functionality of the DVD-ROM or DVD-ROM/CD-RW drive,
additional software (DVD player or burner software) is necessary. You can find it on
the CD included in the delivery of the device. To install the software place the CD
in the drive and follow the instructions on the screen.
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2.7

2-24

Power Unit

External power supply for the SIMATIC Power PG for operation on 120 V or 230 V
power supply networks. The voltage range is selected automatically. The power
unit is connected to the power supply by means of the power cable via the inlet
connector for non—heating apparatus.

Notice

The power plug must be disconnected to isolate the unit completely from mains.

A CSA or UL-listed cord set must be used for operation in Canada and the USA.
For the United States and Canada:

In the United States and Canada the cord must be UL-listed and CSA Labeled.
The male plug is a NEMA 5-15 style.

For operation with 120 V:

Use a UL-listed, CSA Labeled Cord Set, consisting of a min. 18 AWG. Type SVT
or SJT three conductor flexible cord, max. 4.5 m (15 feet) in length and a parallel
blade grounding type attachment plug, rated 15 A, min 125 V.

For operation with 240 V (within the USA):

Use a UL-listed, CSA Labeled Cord Set, consisting of a min. 18 AWG. Type SVT
or SJT three conductor flexible cord, max. 4.5 m (15 feet) in length and a tandem
blade grounding type attachment plug, rated 15 A, 250 V.

For operation with 230 V (outside of USA):

Use a cord set consisting of a min 18 AWG cord and grounding type attachment
plug rated 15 A, 250 V. The cord set should have the appropriate safety approvals
and marks for the country in which the equipment will be installed.

The unit is intended for operation with grounded power supply networks

(TN networks, VDE 0100 part 300 or IEC 364-3).

Operation with non-grounded or impedance-grounded networks (IT networks) is
not permitted.

The cord set must meet safety requirements in the respective country.
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What Does This Chapter Contain?
The chapter below describes all tasks required to successfully set up your
workplace. These include:
 initial steps for commissioning your SIMATIC Power PG,
» connecting peripheral devices,
» working with memory submodules for the PLC and
» connecting your PG to other devices.

Chapter Overview

Section Description Page
3.1 Unpacking and Setting Up the SIMATIC Power PG 3-2
3.2 Connection to the Power Supply 3-4
3.3 Commissioning 3-5
3.4 Connecting Peripheral Devices 3-8
3.5 Working with SIMATIC-S5 memory submodules 3-11
3.6 Working with SIMATIC Memory Cards 3-13
3.7 Working with Micro Memory Cards 3-14
3.8 Working with PC Cards 3-16
3.9 Connecting the Power PG to a SIMATIC S5 Network 3-17
3.10 Connecting the Power PG to a SIMATIC S7 Network (MPI/DP) 3-18
3.11 Networking the Power PG with Other Stations on PROFIBUS 3-20
3.12 Ethernet (RJ45 Ethernet Interface) 3-21
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3.1 Unpacking and Setting Up the SIMATIC Power PG

Unpacking Your SIMATIC Power PG
Unpack your SIMATIC Power PG as follows:
1. Take the device out of the packing.
2. Do not throw the original packing away. Keep it if you need to transport the
device at a later time.
Checking the Delivered Contents
3. Check the packing list to make sure that no components are missing
4. Check the packing and its contents for any transport damages.
5. Please inform your local dealer of any shipping damages and discrepancies
between contents and packing list.
Entering the Serial number (F-No.) and the Ethernet address

6. Enter the serial number and the Ethernet address of your programming
device in the table below. You can find the serial number on the type label
attached to the base of the device. The Ethernet address can be found in the
BIOS setup settings in the main menu under the 'Hardware Options’ function.

If a PC is stolen and subsequently submitted for repair, the repair center will be
able to identify it by the F-No.

F-No.

Order No.

Microsoft Windows Product Key

Ethernet Address

Setting up your SIMATIC Power PG
Find a comfortable and safe working position for your SIMATIC Power PG.

1. Put the SIMATIC Power PG down on its base on an even surface at a
comfortable working height and distance.

2. Ensure there is an easily accessible mains outlet near your place of work.
3. Make sulfficient space available to connect peripheral devices.

4. Remove the keyboard from the device by sliding the locks at the side of the
keyboard downwards and removing the keyboard forwards.

5. You can change the angle of the keyboard by folding out the feet.
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6. Set the desired angle of inclination of the display by pulling it forwards. The
display can set to an angle of between 5 and 30°.

Keyboard lock =

Fig. 3-1 Opening the keyboard

Achtung

Before the initial use insert the batteries into the battery case of the keyboard (4
Mignon cells, Type AA). To do so press on the arrow of the battery cover and slide
it forwards.

Caution

Ensure that the air inlet at the bottom of the device is not covered (danger of over-
heating).

Moisture ingress can damage the PG.

If you transport the device in cold weather and if it is exposed to extreme tempera-
ture fluctuation you have to acclimatize it to room temperature before you start to
operate it.

Do not switch on the device until inside condensation has dried off completely.
This is the case, for example, with a temperature rise from -20 °C to + 20 °C and
after a waiting period of approx. 12 hours.

ii Warning
The computer casing is made of magnesium. Contact with an external open fire
source bears the risk of fire / spreading fire.
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3.2 Connecting to the Power Supply

Connecting to the Power Supply

The SIMATIC Power PG can be operated with the supplied external AC adapter
on 120 V/230 V power systems or with the battery. The external power supply
automatically selects the voltage.

1. Plug the supplied patch cord into the external power supply and plug the
low-voltage plug into the unit’'s connector.

2. Connect the external power supply to a socket outlet with grounded protective
conductor.

ii Warning
Operation of the unit is only permitted on grounded 120V/230V power supply net-
works.
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3.3 Commissioning

Switching on the Power PG

The operating system and system software supplied with the SIMATIC Power PG
are preinstalled on the hard disk. Time consuming installation of the operating
system and SIMATIC software programs is not required. Just unpack and power
up your unit and you can immediately start your programming tasks without having
to take extensive setup actions.

» To power up the device hold down the On/Off switch for on the top side of the
keybord for at least one second. When powering up the device you have to
distinguish between the following cases:

— Initial start to set up the Power PG’s software and a

— Restart after cold start and authorization.

3.3.1 Cold Start of the SIMATIC Power PG

Assigning a New Keyboard Identifier

In the factory setting, your device uses 0 as its specific keyboard ID. A message
(ERROR) on your screen however means no specific keyboard ID was given; you
are the prompted to enter a keyboard ID.

» If you now respond with F1 to this message, the unit continues to operate
without a specific keyboard identifier and all the keyboards can act on the unit.

» If you respond with F2 to this message, the system starts the BIOS Setup.
Proceed as follows:

1. Select one of the offered IDs in the menu Main > Keyboard Features >
Keyboard ID: .

2. Open the keyboard ID menu with the enter key and select a “Num ID” (ID = 0-9)
with the cursor keys.

3. After selecting, it is necessary to synchronize the keybord via the key
combination Fn + ALT + ID (ID = 0-9 of the numeric keyboard area).

Example (setting the Num ID to 5):

Select the menu Main > Keyboard Features > Keyboard ID:  in the BIOS setup.
Use the enter key, then the cursor keys to select the Num ID 5 and acknowledge

with the enter key. Synchronize the keyboard with the PG via the key combination
Fn+Alt+5 ..
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Powering up to the first time

When powering up the SIMATIC Power PG for the first time the operating system
is set up automatically (depending on the version delivered: Windows Me,
Windows NT or Windows 2000 Professional). Please proceed as follows:

1. Switch on the Power PG.

2. The PG executes a self-test. During self-test the following message appears on
the screen:

Press <F2> to enter SETUP

Wait until the message disappears and follow the instructions displayed on the
screen.

3. Enter your product key. The product key can be found on the device behind the
swiveling display in the line “Product Key” of the “Certificate of Authenticity”.

Caution
Do not switch off the PG during cold start. Otherwise, full initialization will fail.
Do not change the BIOS default values.

Startup under Windows

Once you have entered the requisite information and configured the operating
system the PG is rebooted. The Welcome screen helps you to get familiar with
the Desktop - user interface.

Now the user interface is displayed following system startup every time you power
up or reset the PG.

Default country code of the Windows 2000 menus, dialogs and keyboard layout is
English. You can set another language and keyboard via the control panel with the
dialog Start >Settings > Control Panel > Regional Options > tab "General ",
box "Menus and dialogs”> tab "Input locales”, box "Input language”

Authorization

3-6

To use the SIMATIC software e.g. STEP 7 you have to install an authorization,
since it is not possible to run this protected software without authorization. The
authorizations can be found on the Authorization disk that comes with your PG.

To perform the authorization:
* |nsert the authorization disk in drive A:
* Click on the Windows "Start” button and

» select the menu command Simatic > AuthorsW > AuthorsW to open the
authorization tool. It will guide you through the installation routine of the
authorization. Copy the STEP 5 and STEP 7 authorization by selecting “All".
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3.3.2

Notice

Keep the Authorization disk in a safe place so that you can save the authorizations
to disk.

Restart of the SIMATIC Power PG

Once the Power PG is configured, the user interface of the corresponding
operating system is displayed following system startup every time you switch on or
reset the PG.

Starting SIMATIC Software Programs

STEP 5 (not available on all delivered versions)
» Click "Start” on the Windows button and select the desired program choosing
Simatic > STEP 5.

Please note that you have to install the authorization disk before you start
working with STEP 5 (see Section 3.3.1).

Notice

When you use the P Tools (for editing PCP/M files) supplied with STEP 5,
remember that these are not fully supported by the Windows Me and

Windows 2000 operating systems nor by LS120/LS240 diskette drives. If you use
the P Tools, we recommend that you use MS-DOS, Windows 3.x or Windows 95
and standard 1.44 MB floppies.

STEP 7
» Click on the icon “SIMATIC Manager” on the Windows desktop or

» or click on “Start” and select the desired program by choosing Simatic >
STEP 7.

Note

The transfer of a STEP 7 configuration from on PG to another is supported by the
STEP 7 file archiving functions. Open the SIMATIC Manager. select the menu
command File > Archive or File > Retrieve. You can find details on this proce-
dure in the STEP 7 online help, section “Steps to take for Archiving/Retrieving”.

STEP 7-Micro/WIN 32
» Click on the On the "STEP7-MicroWIN“ icon on the Windows Desktop or

» Click "Start” on the Windows task bar and select the desired program with
Simatic > STEP 7-MicroWIN 32.

SIMATIC Power PG Manual
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3.4 Connecting Peripheral Devices

Connecting External Monitors

You must switch the PG off before you connect the monitor cable. You will find
further information about the connector pin assignment in Chapter|7.

=1—— VGA socket

Fig. 3-2 Connecting the Monitor

To connect the monitor, proceed as follows:
Switch off the SIMATIC Power PG and the monitor.
Open the port cover on the left—-hand side of the device.

Plug the monitor cable into the VGA socket connector.
Secure the connector with the screws.
Plug the other end of the monitor cable into the monitor.

Switch on the SIMATIC Power PG and the monitor.

N o o s~ 0w DNPRE

Make the necessary changes in the SETUP program (Menu > Main >
Hardware Options , for example “CRT enabled”, “LCD enabled”
“SIMULTANEOUS").

Note

Default setting is simultaneous operation of the flat screen display and of an external
monitor. The display unit is optimized for a format of 1024*768 pixels. Modes with lo-
wer resolution and text mode are expanded to this format.

You can optimize the external monitor display via BIOS Setup in the Main menu item
Hardware Options or the setting "CRT/LCD selection: CRT enabled”.

SIMATIC Power PG Manual
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Caution
Ensure that the used monitor is suitable for the set resolution and refresh rate.

Connecting Devices to an USB Interface

You can connect single or multiple USB devices (mouse, keyboard or printer) to
the USB interfaces.

1. Open the port cover on the left—hand side of the device.
2. Plug the USB device cable into one of the USB interfaces.

The Plug and Play operating system recognizes the device. Any drivers are
requested by the operating system, if necessary.

If you wish to connect more than two USB devices you must use a HUB. Only one
of the interfaces can be used as high-current source (refer to the Appendix B,
Technical Data).

=

USB connectors

K — [@l

18
|

Fig. 3-3 USB connectors

Note

Devices that do not have a USB plug (for example, printers) can be connected to
the USB interface via adapter.

Using a Mouse

You can connect a USB mouse parallel to the Touchpad.

SIMATIC Power PG Manual
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Connecting a Microphone

The 3.5-mm phono jack can be used to connect microphones. Pin assignment:

Mic Mic-
Power ground

3.5-mm microphone plug

Fig. 3-4  Pin assignment of the microphone plug

For microphone recordings, select Programs > Accessories > Multimedia >
Audio Recorder in the Windows Start menu.

Connecting a Headphone

3-10

You can connect headphones or active speakers with 3.5-mm stereo phono plugs
to this jack.

Loudness is controlled via taskbar button or Programs > Accessories >
Multimedia > Loudness in the Windows Start menu. The internal speakers are
switched off when a headphone is connected.

3.5-mm headphone stereo phono plug

Fig. 3-5 Headphone stereo phono plug

SIMATIC Power PG Manual
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3.5 Working with SIMATIC S5 Memory Submodules

Editing SIMATIC S5 Memory Submodules

You can read and program SIMATIC S5 memory submodules (EPROMSs or
EEPROMS) via the Memory Card interface. Use the S5 adapter for S5 memory
submodules that is included in the scope of delivery for devices with Step 5
software. The S5 adapter consists of a Memory Card plug with an interface for the
connection of S5 memory modules. Refer to the STEP 5 manual for information on
operating the programming software.

Slot for S5 Adapters,
for SIMATIC S5 memory modules
and SIMATIC Memory Cards

Type label pointing

Fig. 3-6 S5 Module Programming Interface

Notice
The S5 adapter and STEP 5 software is not included in all delivered versions.

Proceed as follows when working with S5 memory modules :

1.
2.
3.

Switch on your device.
In your STEP 5 software, start the function Administration > Edit EPROM

With the type label pointing to the rear, insert the SIMATIC S5 Memory Card or
the S5 adapter into the Memory Card interface and then the S5 memory
module.

You can read, program or erase (EEPROMSs only) your S5 memory module with
the EPROM functions of the STEP 5 software.

Extract the S5 memory module.
Close the EPROM functions of your STEP 5 software.

SIMATIC Power PG Manual
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Caution

You might damage the module if you insert or extract it while editing is in progress.
You must not remove the S5 memory module as long as the module programming
status display is lit.

Always discharge your body’s static electricity by briefly touching a grounded part
of the device before you insert an S5 Memory Card.

SIMATIC Power PG Manual
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3.6 Working with SIMATIC Memory Cards

Working with SIMATIC Memory Cards

SIMATIC memory cards can be read, programmed, and erased. SIMATIC memory
cards are available for SIMATIC S5 and SIMATIC S7 software.

SIMATIC Memory Card

Type label pointing

Fig. 3-7 Slot for SIMATIC Memory Cards

Proceed as follows when working with SIMATIC memory cards:
1. Switch on your device.
2. Start your SIMATIC programming function.

3. Plug a SIMATIC Memory Card into the Power PG slot. Correct insertion
direction is spot marked on the Power PG and on the Memory Card.

4. You can read, program, or erase the Memory Card with the programming
function of your SIMATIC programming software.

5. Close the programming function of your SIMATIC software.

6. Remove the SIMATIC memory card from the programming port for further use
in a programmable logic controller.

Caution

You must insert the Memory Card with the type label pointing towards the rear of
the unit.

You must not remove the SIMATIC Memory Card while the module programming
status LED is lit.

Always discharge your body’s static electricity by briefly touching a grounded part
of the device before you insert a SIMATIC Memory Card.

SIMATIC Power PG Manual
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3.7 Working with Micro Memory Cards

Working with Micro Memory Cards

Read, program and erase Micro Memory-Cards (MMC) via the Micro Memory Card
interface. Operation with Micro Memory Cards is supported by STEP 7 V5.1 or
higher.

Micro Memory Card

Fig. 3-8 Slot for Micro Memory-Cards

Proceed as follows when working with Micro Memory Cards:
1. Switch on your device.
2. Start your SIMATIC programming function.

3. Insert the Micro Memory-Card into the slot on the side of the device. The card’s
connector is encoded for insertion in one position only (with inclination
downwards). A symbol on the PG housing indicates the plug-in direction.

4. Read, program, or erase the Micro Memory Card with the programming function
of your SIMATIC programming software.

5. Close the programming function of your SIMATIC programming software.

6. Remove the Micro Memory-Card from the interface.

Caution

You must not remove the SIMATIC Micro Memory Card while the module pro-
gramming status display is lit.

Always discharge your body’s static electricity by briefly touching a grounded part
of the device before you insert a SIMATIC Micro Memory Card.

SIMATIC Power PG Manual
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Note

Parallel operation of a Micro Memory Card (MMC) and of a Memory Card is not possi-
ble. The PG is equipped with a priority circuit that switches off the MMC interface
when a Memory Card is inserted. The internal MMC is switched off as soon as a Me-
mory Card, an S5 adapter or an MMC adapter is added.

SIMATIC Power PG Manual
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3.8

PC-Cards

3-16

Working with PC Cards

The PC card interface supports two type Il or one type Il Cardbus card (32-bit) or
PCMCIA card (16-bit). The SIMATIC Power PG has two PC card ports. You can
plug credit-card format communication modules for MODEM, FAX-MODEM, ISDN,
Token Ring, ETHERNET, memory expansion and SCSI interface modules into
these ports.

PC card interface, type /Il
(Slot 1)

PC card interface, type l/II/1II
(Slot 2)

Ejector for PC cards

Fig. 3-9 PC Card interface

The PC-Card ejectors have a ballpoint pen mechanism. Before you insert the card
ensure that the ejector is engaged. To remove the PC-Card, push the ejector once
to unlock it and a second time to eject the card.

Caution
When you plug in the PC-Card, the Label must point forwards.

Remove the card only after all data traffic has terminated (risk of data loss and
system failure).

You might damage the SIMATIC Power PG and the PC-Card if you attempt to in-
sert the card the wrong way round.

Always discharge your body’s charge of static electricity by briefly touching a
grounded part of the device (e.g. the metal mount of the port) before inserting or
removing a card (in accordance with the instructions for handling electrostatically-
sensitive components, EGB guidelines). Otherwise, disruptions might occur.

Notice

In order to use a PC card you must enter BIOS-SETUP, open the Main menu, se-
lect the Hardware Option submenu and set “Cardbus/PCMCIA Slot” to “Enabled”.

SIMATIC Power PG Manual
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3.9 Connecting the Power PG to a SIMATIC S5 Network

Point-To-Point Connection

In this section, you will learn how to connect your Power PG to a programming
device or S5 PLC using a point-to-point connection.

You can establish a point-to-point connection by connecting the Power PG to
another programming device using a TTY connection.

Notice
The interface is connected to potential.

The SIMATIC STEP 5 programming software and the patch cord for the connec-
tion to the S5 PLC is not supplied with all versions.

Connecting the Power PG to the S5 PLC

You can connect the Power PG to a SIMATIC S5 PLC via COM1/TTY interface
port. The patch cord for connecting to SIMATIC S5 CPUs is not included with all
delivered versions ( Order no.: 6ES5734-2BD20).

—
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—
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SIMATIC S5 patch cord
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Fig. 3-10 Connecting to an S5 PLC

You connect your Power PG to a SIMATIC S5 PLC as follows:

1. Switch off your device.

Open the cover of the interface ports on the left—hand side of the device.
Connect the patch cord to the COM1/V.24-Modem/PLC port.

Secure the connector with screws.

A S A

Connect the patch cord to the corresponding port on the CPU of the PLC.

Caution

The interface port may be damaged if you use the wrong patch cord.

SIMATIC Power PG Manual
A5E00097462-02 3-17



Configuring And Operating The SIMATIC Power PG

3.10

Connecting the Power PG to a SIMATIC S7 Network
(MPI/DP)

Connecting an S7 Programmable Controller via an MPI/DP Interface

3-18

You can use the potential-separated*) MPI/DP interface to connect the SIMATIC
Power PG to a SIMATIC S7 programmable controller or to a PROFIBUS network.
The MPI patch cord (5m) for connecting to SIMATIC S7-CPUs (Order no.:
6ES7901-0BF00-0AAO) is included in the consignment. The data transfer rate is
limited to 187.5 Kbit/s when using this patch cord. For baud rates > 1.5 Mbit/s you
must use a PROFIBUS cable for 12 Mbit/s (Order no. 6ES7901-4BD00-0XA0).

For environments free
of interference:

Bus connector
6ES7972-0BB10-0XA0
or
6ES7972-0BB20-0XA0
6ES7901-0BF00-0AAO

(5-m length)

MPI/DP interface

Fig. 3-11  Connection Using the MPI/DP Interface

Proceed as follows when connecting to a SIMATIC S7 programmable logic
controller:

1. Switch off your device.
2. Open the interface cover.

3. Connect the cable to the MPI/DP interface.

Caution

Before plugging in the cables, the static charge on your body, the unit, and the
cables must be equalized. You can do this by briefly touching the metal mounting
plate for the interfaces on the left—-hand side of the device.

*) Electrical isolation in the safety extra-low voltage circuit (SELV circuit).
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Connecting

Via the MPI/DP interface, you can connect your programming devices to
* MPI networks (S7-200, S7-300, and S7-400) or
* PROFIBUS DP networks (DP components).

MPI/PROFIBUS DP Network

Up to 32 devices (PC, PG, or AS) can be connected to the MPI/DP interface to
form a network segment. The physical connection to the MPI/PROFIBUS DP
network is via a floating RS485 interface which is a component of the PG basic
module.

Several MPI/PROFIBUS DP network segments can be connected via repeaters.
The complete MPI/PROFIBUS DP network can comprise up to 127 stations. Data
transmission rates from 9.6 Kbps to 12 Mbps are possible in the PROFIBUS-DP
MPI network.

SIMATIC Power PG Manual
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3.11 Networking the Power PG with Other Stations on
PROFIBUS

Networking the SIMATIC Power PG on PROFIBUS

PROFIBUS is an open and robust bus system for industrial use. It can be used to
configure networks with up to 32 stations per segment. PROFIBUS-DP supports
data-transfer rates from 9.6 Kbaud to 12 Mbaud.

How the Network Functions

The network operates on the “Master-Slave Principle with Token Passing”
(complying with DIN19245, PROFIBUS). It distinguishes between active and
passive stations. An active station receives the token and passes it on to the next
station within a specified time.

Hardware Requirements

Using the following components, for example, you can connect or network the
SIMATIC Power PG with PROFIBUS:

* RS 485 MPI/DP interface adapter, integrated

» Shielded, twisted pair (bus cable or connecting cable to network).

SIMATIC Power PG Manual
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3.12 Ethernet (RJ45 Ethernet Interface)

Networking Power PG via RJ45 Ethernet Interface

The RJ45 Ethernet interface is a Twisted-Pair (TP) Interface for data transfer rates
of 10/100 Mbaud. This on-board interface is compatible with Intel pro/100+ PCI
Adapters.

The Plug & Play interface is automatically recognized in Windows. Protocols are
configured in the Windows system control.

=]

u RJ45-Ethernet Port

=—it=mC

Fig. 3-12  Ethernet Port

Notice
A Class 5 Ethernet cable is required for operation with 100 Mbaud.
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What Does This Chapter Contain?

A

This chapter shows you how to expand your SIMATIC Power PG with additional
expansion memory submodules to increase its performance. Please note the
included comments on safety.

Chapter Overview

Section Description Page
41 Opening the Unit 4-2
4.2 Installing Memory Expansion Submodules 4-4
4.3 Processor Upgrade 4-6
4.4 Installing Memory Expansion Cards 4-7
45 Closing the Unit 4-8
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4.1

Opening the Unit

Prerequisites

/N

The programming device is designed to enable any necessary maintenance work
to be carried out quickly and at low cost.

Caution

The electronic components of the printed-circuit boards are extremely sensitive to
electrostatic discharge. When handling the boards, you must follow the guidelines
for electrostatically-sensitive components (ESD guidelines) at the end of this book.

Limitation of Liability

All technical specifications and licenses apply only to expansion functions
approved by Siemens.

No liability can be assumed for functional constraints caused by the use of devices
and components of other manufacturers.

All modules and components in the PG 740 PIII are electrostatically sensitive.
Please read the ESD guidelines at the end of this book carefully. The following sign
on cabinets, module racks or packaging warns that electrostatically-sensitive
modules are present.

A
Arad

Before Opening the Unit

4-2

The following rules are mandatory when carrying out any work on the open unit,
and should be read carefully before opening the unit:

» Before you disconnect the power supply cable, discharge any electrostatic
charge on your body. You can do this by touching metallic parts, such as
screws, on the rear panel of the PG 740 PIII.

» Discharge any electrostatic charge from tools that you are using.
» Wear a grounding wrist strap if you are handling components.

» Leave components and modules in their packing until you are ready to install
them.

» Disconnect the PG 740 PIII from its power supply before plugging in or
removing any modules or components.

SIMATIC Power PG Manual
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» Touch components and modules only on their edges. Above all, do not touch
the connecting pins and printed conductors.

» Do not operate the PG 740 PIIl with the cover open.

Tools

Use a suitable TORX screwdriver to loosen the TORX screws.

Opening the Power PG
Open your Power PG as follows:

1. Switch off the Power PG, pull out the power plug, and remove all connecting
cables and Steckleitungen.

2. L6sen Sie nun die finf Schrauben an der Riickwand.

3. Pull off the rear panel to the rear.

SIMATIC Power PG Manual
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4.2 Installing Memory Expansion Submodules

Standard Memory

The motherboard has three slots for 168 pin DIMM memory submodules. This
allows you to expand the memory capacity of your SIMATIC Power PG to a
maximum of 512 Mbytes.

Slots for DIMM memory
submodules

Processor

/ —/

=

Fig. 4-1 Positions of the DIMM Memory Submodules

You can install submodules of different capacity. Only one module must be
installed. Refer to the catalog for the ordering data for suitable modules.

Memory Modules
128 Mbytes | 256 Mbytes
128 Mbytes 1 -
256 Mbytes 2 -
256 Mbytes - 1
384 Mbytes 3 1
384 Mbytes 1 1
512 Mbytes - 2

SIMATIC Power PG Manual
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Caution

The electronic components of the printed circuit boards are highly sensitive to
electrostatic discharge. Certain precautionary measures are therefore necessary
when handling such components. These measures are explained in the guidelines
for handling electrostatically-sensitive devices in Appendix A.

Installing memory submodules
To plug in expansion submodules, proceed as follows:

1. Switch off the device.

Caution

Do not install a memory module while the PG is switched on. You might damage
the PG as well as the memory module.

2. Disconnect all cables on the device.
3. Open the unit as described in Section 4.1.

4. Plug the module into the slot. Note the recess (reversal protection) on the plug
side of the DIMM module.

5. Push the module down by applying light pressure until it locks into place.

6. Close the unit as described in Section 4.5.

Caution

The modules must be inserted firmly into the base in order to avoid malfunctions.

The memory configuration is detected automatically. When you switch on the unit,
the distribution of “System and Extended Memory” is displayed on-screen.
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4.3 Processor Upgrade

You can boost the performance of your SIMATIC Power PG with a processor
upgrade. Consult your local dealer or service partner.

Notice

If an upgrade is implemented, for example to a processor with a different fre-
guency, it may be important to also upgrade the BIOS.

You must only install components approved by Siemens.

SIMATIC Power PG Manual
4-6 A5E00097462-02



SIMATIC Power PG Expansions

4.4 Installing Memory Expansion Cards

Installing Expansion Modules

You can extend the functionality of your Power PG by installing additional modules.
Two expansion slots are provided on the bus board for this purpose.

The following modules can be fitted:

Slot Modules
1 PCI <170 mm
2 PCI <170 mm

The current drawn per PCI module must not exceed the following values:

+5V 16A

+12V 0.3A

-12V 50 mA

-5V 50 mA
Signals one TTL load

PCI mocule

=

Fig. 4-2 Open Power PG with Expansion Module
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ii Caution
Risk of damage
The electronic components of the printed-circuit boards are extremely sensitive to

electrostatic discharge. Please observe the guidelines for electrostatically-sensitive
devices (ESD guidelines), otherwise the module or device may be damaged.

Plugging in the Module
You plug expansion modules in as follows:
1. Open the unit as described in Section 4.1.
2. Remove the dummy plate on the casing side panel.
3. Plug the module into a free slot.
4. Bolt the module backplane to the casing side panel.
5

. Close the unit as described in Section 4.5.

4.5 Closing the Unit

Procedure
To close the unit, proceed as follows:

1. Place the enclosure rear panel on the top of the enclosure (top edge with guide
nose).

2. Close the rear panel.
3. Screw on the rear panel with the five screws.

4. The unit is now ready to operate.
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What Does This Chapter Contain?

In this chapter, you will learn how to configure your programming device. You need

to do this if you change your system by adding, removing, or exchanging

expansion modules and memory expansions, or by replacing a system module.

Chapter Overview

Section Description Page
5.1 Changing the Device Configuration with SETUP 5-2
5.2 The Main Menu 5-5
5.3 The Advanced Menu 5-15
5.4 The Security Menu 5-20
5.5 The Power Menu 5-22
5.6 The Boot Sequence Menu 5-24
5.7 The Version Menu 5-26
5.8 The Exit Menu 5-27
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5.1 Changing the Device Configuration with SETUP

Changing the Device Configuration

Your PG configuration is set for working with the software supplied with the unit.
You should only change the preset values if you have modified your Power PG in
any way or if a fault occurs when the unit is powered up.

SETUP-Program

The SETUP program is in the ROM-BIOS. Information about the system
configuration is stored in the battery-buffered RAM of the SIMATIC Power PG.

You can use SETUP to set the hardware configuration (for example, hard disk
type) and define the system characteristics. You can also use SETUP to set the
time of day and date.

Incorrect SETUP Data

If incorrect SETUP data are detected when you boot the system, the BIOS
prompts you to:

e Start SETUP by pressing F2 or
» Continue booting by pressing F1.

Starting SETUP

On completion of the startup test, the BIOS gives you the opportunity of starting
the SETUP program by displaying the following screen prompt:

PRESS < F2 >to enter SETUP

To start SETUP, proceed as follows:
1. Reset your PG (warm or cold restart).

2. Press the F2 key as long as the BIOS prompt appears on the screen.

SETUP Menus

The various menus and submenus are listed on the following pages. You can get
all the information you need for the SETUP entry selected from the “Item Specific
Help” part of the relevant menu.

SIMATIC Power PG Manual
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Screen Display Following Power On

With the standard setting of your PG, the screen displays after power-on, for
example:

PhoenixBIOS 4.0 Release 6.0 —ASE0001xxxx-ES00x
Copyright 1985-2000 Phoenix Technologies Ltd.
All Rights Reserved

SIEMENS Power PG, Version V10.02.xx

CPU = Pentium(R)IIl processor 866MHz

640K System RAM Passed

128M Extended RAM Passed

256K Cache SRAM Passed

System BIOS shadowed

Video BIOS shadowe d

Fixed Disk 0: FUJITSU MPG3204AT E—(PM)

ATAPI Removable Drive: LS-120 SLIM$ 00—(SM) UHD Floppy
ATAPI CD-ROM: TOSHIBA DVD-ROM SD-C2502

Mouse initialized

Press <F2> to enter SETUP

Notice

All information on on-screen displays and menu displays are samples. Deviations
to this example are possible.

Press the F2 key while the above display is shown, to select the ROM-based BIOS
setup program. In this program, you can set a number of system functions and
hardware configurations of your programming device.

The standard settings are effective on delivery. You can change these settings
using the BIOS setup. The modified settings become effective when you have
saved them and terminated the BIOS setup.
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The following screen form appears when you start the BIOS setup:

Header
Menu bar

submenu

Operating keys

Selectable /

Main Advanced Security Power Boot Sequence Version  Exit
Item Specific Hel
[fE:35:32] P P
System Date: [ 09/05/2001 ]
. . <Tab>, <Shift-Tab>, or
Legacy Diskette A: [Disabled] <Enter> selects Power.
» Primary Master [20496 MB] Example:
» Primary Slave [None] Hour/Minute/Second
» Secondary Master [ATAPI Removable] Month/Day/Year
» Secondary Slave [CD-ROM]
Memory Cache: [Write Back]
» Boot Options
» Keyboard Features .
» Hardware Options Al
System Memory: 640 KB
Extended Memory: 129536 KB
El Ay = F9
ESC > Enter F10

Fig. 5-1

Menu Structure

Main SETUP Menu (sample)

The screen is divided into four sections. In the top section, you can select the
menu screens [Main], [Advanced], [Security], [Power], [Boot Sequence],
[Version], [Exit]. In the left of the center section you can select various settings or
submenus. Brief help texts appear on the right for the currently selected menu
entry. The bottom section contains information for operator inputs.

You can move between the menu screens using the cursor keys [ -] and [-].

Menu

Meaning

Main

System functions are set here

Advanced

An extended system configuration can be set here

Security

Security functions are set here, for example a password

Power

Power functions can be selected here

Boot Sequence

The boot priorities are defined here

Version

Information about the programming device’s release status

Exit

Used for terminating and saving

5-4
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5.2 The Main Menu
Main Advanced Security Power Boot Sequence  Version Exit
Item Specific Hel
(PB:35:32 ] - 2
System Date: [ 09/05/2001 ]
. . <Tab>, <Shift-Tab>, or

Legacy Diskette A: [Disabled] <Enter> selects Power.

» Primary Master [20496 MB] Example:

Selectable > Primary Slave [None] Hour/Minute/Second
submenu » Secondary Master [ATAPI Removable] Month/Day/Year

» Secondary Slave [CD-ROM]
Memory Cache: [Write Back]

> Boot Options

» Keyboard Features

» Hardware Options
System Memory: 640 KB
Extended Memory: 129536 KB

Fl 4y = F9

ESC <+« Enter F10

Fig. 5-2 Main SETUP menu (sample)

Settings in the Main Menu

In the Main menu, you can move upwards and downwards using the cursor keys
[t] and [!] to select the following system parameters:

Field

Meaning

System Time

For viewing and setting the current time

System Date

For viewing and setting the current date

Diskette A

Type of built-in floppy disk drive

Memory Cache

For setting the cache options

By submenus

Primary Master

Type of built-in drives

Secondary Master

Type of built-in drives

Boot Options

For setting boot options

Keyboard
Features

For setting keyboard-interface options (e. g. NUM Lock, Typematic
Rate)

Hardware Options

For setting PG hardware options

SIMATIC Power PG Manual
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System Time und System Date

Diskette A

System Time and System Date indicate the current values. Once you have
selected the appropriate option, you can use the [+] and [-] keys to modify the time
setting

Hour:Minute:Second
and the date
Month/Day/Year.

You can move between the entries in the date and time options (for example, from
hour to minute) using the tabulator key.

The type of disk drive built-in to the PG is set here. The following entries are
possible:

[Disabled] If a floppy drive or an LS120 drive does not exist (default)

[1.44 MB, 3 1/2"] Setting for an integrated floppy drive A: for 3 1/2 inch/1.44 MB disks

Primary Master Primary Slave Secondary Master / Secondary Slave

5-6

When you select such a menu field via Enter key the following submenu is opened:

_

Primary Master [20496 MB] Item Specific Help
[Auto] (recommended)
Autotypes installed
JAutol IDE-devices
LBA Format
Total Sectors: [40031712] [USER]
Maximum Capacity: 20496 MB Enter parameters of
IDE-devices installed
Multi-Sector Transfers: [16 Sectors] at this connection
LBA Mode Control: [Enabled]
32 Bit I/O: [Enabled]
Transfer Mode: [FPIO 4 / DMA 2]
Ultra DMA Mode: [Mode 5]
F1 4y +/— F9
ESC > Enter F10
Fig. 5-3 Primary Master
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"Type” Field

The parameters you can select here are usually stored on the IDE drive. The "Auto’
setting in the 'Type’ field means that these values are automatically read from the
drive and written into memory .

If Type is selected for a drive that cannot be detected, a timer times out in
approximately 1 minute and the entries remain unchanged. You should always
check that the interfaces for which you select 'Auto’ are in fact connected to drives.

Select “User” if you want to define the hard-disk type yourself, in which case
remember that you also have to set the other fields, including Cylinder, Heads,
Sectors/Track and WritePrecomp, to the correct values for the type of hard disk in
guestion.

"Multi-Sector Transfer” Field

The entry in the Multi-Sector Transfer field defines the number of sectors
transferred per interrupt. The value depends on the drive and should be set only by
setting the Type field to Auto.

Disabled
2,4,8,16 sectors

"LBA Mode Control” field

If the LBA Mode Control field (enabled, disabled) is set to 'Enabled’, the system
supports hard disks with capacities greater than 528 Mbytes. The value depends
on the drive and should be set only by setting the Type field to Auto.

"32 Bit I/O” Field
The setting in the 32 Bit I/O field defines the mode of access for the drive
Disabled 16-Bit access

Enabled 32-Bit access (default)

"Transfer Mode” Field

The settings in these fields define the interface’s data-transfer rate. The value
depends on the drive and should be set only by setting the Type field to Auto.

Hit ESC to exit the submenu.

SIMATIC Power PG Manual
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“Memory Cache” Field

Wird im Main-MenU das Feld "Memory Cache” gewahlt erscheint folgendes

Kontextmend:
Main Advanced Security Power Boot Sequence  Version Exit
Item Specific Hel

(PB:35:32 ] - #

System Date: [ 09/05/2001 ]

Legacy Diskette A: [Disabled] Controlsieachingjof

; system conventional

Primary Master [20496 MB] memory and memory

[None] above one megabyte.

Secondary Master
Secondary Slave

>
» Primary Slave
>
>

Boot Options
Keyboard Features
Hardware Options

[ATAPI
[CD-RQ

rite B | Write Back

System Memory: 640 KB

Extended Memory: 129536 KB
=1 4y +/— F9
ESC > Enter F10

Fig. 5-4

“Memory Cache” Field

A cache is a fast memory buffer between the CPU and main memory (DRAM).
Recurrent memory access operations are executed in the fast cache, instead of
main memory, if the function is enabled. In rare instances involving some hardware
and software combinations, it may be necessary to disable the cache because the
program runtimes or waits are too short on account of the fast cache.

[Disabled]

Cache is disabled

[Write Through]

memory

Write access is not concluded until the entry has been made in main

[Write Back]

Write access is concluded immediately, the entry in main memory takes
place in the background (default)

SIMATIC Power PG Manual
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Option “Boot Options”

The following submenu appears when you select the option “Boot Options” in the

main menu:
_
Boot Options Item Specific Help
[ SEED] Allows the system to
skip certain tests
while booting. This
SETUP prompt: [Enabled] will decreasg the
POST Errors: [Enabled] time needed to boot
. the system.
Floppy check: [Disabled]
Summary screen: [Enabled]
F1 4y +/- F9
ESC <> Enter F10
Fig. 5-5 "Boot Options” Submenu
Quick Boot Some hardware tests are skipped to speed up the boot procedure.
Mode

SETUP prompt | The message PRESS <F2> to enter Setup appears at the bottom of the

screen during the system run-up phase.

POST Errors The boot process is stopped if an error is detected; you must press F1 to

confirm. Enter “Disabled”to avoid the necessity of acknowledging errors.

Floppy check The floppy head is stepped inward and then back to its original position

during the system run-up phase. This test is useful because it reinitiali-
zes the drive.

Summary The most important system parameters are displayed when the system
screen

run-up phase completes.

'Enabled’ means that the feature is active. 'Disabled’ means that the feature is
inactive.

SIMATIC Power PG Manual
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Example of a Summary screen:

PhoenixBIOS Setup Utility

Fig. 5-6 Summary Screen

The Summary screen appears when the system run-up phase completes.

SIMATIC Power PG Manual
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Option “Keyboard Features”

The following submenu appears when you select the “Keyboard Features” field in
the main menu:

_

Keyboard Features Item Specific Help
| Onlf Selects Power-On state
Key Click: [Disabled] for NumLock on next boot
Keyboard auto-repeat rate:  [30/sec]
Keyboard auto-repeat delay: [1/2 sec]
Keyboard ID [Invalid]

No valid Key ID. Please
select one and then con-
firm with FN + ALT + ID

F1 Ay +/- F9
ESC “«> Enter F10

Fig. 5-7 "Keyboard Features” Submenu

Numlock Switches Numlock on or off following power on

Key Click A keystroke can be heard

Keyboard auto-repeat | Increase of the automatic keyboard rate
rate

Keyboard auto-repeat | On-delay of automatic keyboard repeat
delay

Keyboard ID Assigns a specific ID to the keyboard. FN + ALT + ID
synchronizes the unit and the keyboard.

ID corresponds to a number between 0 and 9 of the numeric
block.

SIMATIC Power PG Manual
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“Hardware Options” Field

5-12

The following submenu appears when you select the “Hardware Options” field in

the main menu:

_

Hardware Options Item Specific Help
[lEnabledf] Enable or _disa}ble the
Programming interface: [Enabled] [PCY = Ui (el
Interface (MP1/DP)
Cardbus / PCMCIA Slot: [Enabled]
Onboard Ethernet [Enabled] Also, this item
Ethernet Address 080006246F73 Enables / Disables the
LAN remote boot: [Disabled] SIMATIC programming
Legacy USB Support: [Disabled] interface.
Fan Control: [Enabled]
CRT / LCD selection: [SIMULTAN]
LCD-Screensize: [Graph&Text Expand]
Display Brightness: [normal]
Touchpad: [Enabled]
Sound: [Enabled]
F1 Ay +/— F9
ESC > Enter F10
Fig. 5-8 "Hardware Options” Submenu

The parameters of the interfaces present on the basic module are set here.

Entry

PCI - MPI / DP

Enables the CP5611 compatible MPI/DP interface.

Programming interface

Displays enable or disable status of the SIMATIC Memory Card
Interface. Enable follows the enable of PCI-MPI/DP.

Cardbus / PCMCIA
Slot

[Disabled]

[Enabled]

Enable Cardbus / PCMCIA-

interface deactivated.

Resources are managed by BIOS PCI
Plug & Play mechanisms.

SIMATIC Power PG Manual
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Entry

Meaning

Onboard Ethernet

Enable the on-board Ethernet interface. Resources are managed
by the BIOS PCI Plug & Play mechanism.

[Disabled] Ethernet inactive.
Ethernet interface hardware is switched off.
The operating system can not operate the interface
[Enabled] Ethernet active.
Subsequent plugging of the network cable
and its operation possible at any time (Hot-Plug).
If no cable is plugged on system start
the device checks during the boot sequence, for a
time of approx. 30 seconds, and when recovering
from suspend mode, for a time of approx.
40 seconds, for an existing Ethernet connection.
Noticeable delays do not occur as long as an
active network connection does not exist.
LAN Remote Boot [Enabled] Booting using a connected LAN is possible.
The respective boot source is displayed as
IntelD Boot-Agent in the boot sequence menu.
[Disabled] Booting using LAN is not possible.
Legacy USB Support | [Disabled] Default setting for operating system with its own
USB support.
[Enabled] This setting makes it possible for non-USB
capable operating systems to be used.
Fan Control [Enabled] Fan speed depends on temperature.
[Disabled] Fan always runs at full speed.

CRT / LCD selection

[LCD Enabled] All data is output only to the internal LCD,

the 15-way VGA port is disabled

[CRT Enabled] For maximum resolution the display signals are

output only to the 15-way VGA port; the LCD
interface of the VGA controller is disabled.

[Text expand]

[SIMULTAN] Both display interfaces are enabled and
operate simultaneously. Note, however, that the
LCD does not support all resolutions.
LCD Screensize [Normal] The display window in Text and Graphic

modes is not expanded to full screen size.

Only the Text modes are expanded to full
screen size.

[Graphic expand]Only the Graphic modes are expanded to full

screensize.

[Graph&Text expand]

The Graphic and Text modes are expanded
to full screen size.

Display Brightness

[Normal]
[most bright]
[darkest]

Setting the brightness of the display:
To medium brightness

Brighter
As dark as possible

SIMATIC Power PG Manual
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5-14

Entry Meaning
Touchpad [Enabled] The Touchpad is switched on.
[Disabled] The Touchpad is switched off
Note: All modifications of this interface are not active
until a restart of the PG.
Sound [Enabled] Sound is enabled.
[Disabled] Sound is disabled.

The resources used by an interface are released when you disable the interface in

guestion.
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53 The Advanced Menu

Main Advanced Security Power  Boot Sequence Version Exit

Item Specific Help

Setting items on this menu to incorrect values may
cause your system to malfunction Peripheral Configuration

» PCI Configuration

Installed O/S: [Other]

Reset Configuration Data: [Yes]

Floppy Disk Controller: [Disabled]

Large Disk Access Mode: [DOS]

Local Bus IDE adapter: [Primary & Secondary]
Memory Gap at 15 Mbyte: [Disabled]

Default Primary Video Adapter [AGP]

F1 Ly +/- F9
ESC “«> Enter F10
Fig. 5-9 "Advanced” Menu

Settings in the Advanced Menu

Installed O/S Plug & play means that all modules are automatically detected
and installed, providing they support the Plug&Play functionality.
[Other]  BIOS handles the entire Plug&Play capability, default
configuration
[Win95] The operating system handles part of the Plug& Play
[Win98] functions
[WinME/2K]
The operating system handles a part of the
Plug&Play functions

Reset Configuration [Yes] All installations under Plug&Play are deleted and
Data reconfiguration is triggered the next time the system
boots. The entry is then reset to [No]. System
components that do not support Plug&Play have to be
entered manually.

[No] The Plug&Play system components are initialized
after the next system start.

Floppy disk controller | Enabling or disabling the floppy controller of the basic module

Large Disk Access [DOS] Drive letters are constructed according to
Mode Enhanced IDE compatible DOS drive access.

[Other]  The tables are not adapted.

SIMATIC Power PG Manual
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Local Bus IDE adapter

[Primary]
[Secondary]
[Primary & Secondary] Two IDE adapters for max. four drives.

[Disabled] No local IDE adapter.

One IDE adapter for max. two drives.

Memory Gap at 15 MB

[Disabled] The complete onboard RAM memory is available.
[Enabled] A 1MB area of the RAM above 15MB
(Addresses FO 0000 — FF FFFF) can be used by ISA
expansion cards.

Default Primary Video
Adapter

[AGP] Setting for AGP Video Cards
(Default setting)
[PCI] Setting for PCI Video Cards

“COM/LPT Configuration” Submenu

m

5-16

COMI/LPT Configuration

Item Specific Help

Parallel port:
Mode:

Internal COM 1:
Base /O address: [3F8]
Interrupt:

[Enabled] Configure serial port A
using options:

=] [Disabled]

No configuration

[OS controlled] [Enabled]
[ECP] User configuration

[Auto]
BIOS or OS chooses
configuration

[OS Controlled]
Displayed when
controlled by OS

F1
ESC

4>
v+

+/— F9
Enter F10

Fig. 5-10

"COMY/LPT Configuration” submenu
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“PCI Configuration” Submenu

Advanced
PCI Configuration Item Specific Help
» PCI Device, Slot #1 Setup iter_n_s for configuring
» PCI Device, Slot #2 The specific PCI device

» PCI/PNP ISA IRQ Resource Exclusion

PCI IRQ line 1: [Auto Select]

PCI IRQ line 2: [Auto Select]

PCI IRQ line 3: [Auto Select]

PCI IRQ line 4: [Auto Select]

F1 Fu +/— F9

ESC <+« Enter F10
Fig. 5-11 "PCI Configuration” Submenu

"PCI-Device” Field

If the “PCI Device” field is selected, the following submenu appears:

PCI Configuration Item Specific Help
Option Rom Scan [Enabled] Setup iter_n_s for configuring
Enable Master: [Disabled] The specific PCI device
Latency Timer: [0040h]
Fl A l= F9
ESC <+« Enter F10

Fig. 5-12 Submenu "PCI Device, Slot #1”
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Option ROM [Enabled] The option ROM of the PCI module (if present) is
Scan: enabled
[Disabled] The option ROM of a PCI module is disabled.
Enable Master: | [Enabled] This slot can assume the PCI master function
[Disabled] This slot can only operate as a PCI slave.
Latency Timer | [Default] The number of active PCI clock cycles of the master
modules are determined by the module
[0020H With these settings, the maximum active PCI clock
to cycles are set to the selected value.
00EOH]

Submenu IRQ Resource Exclusion

The 1/0 addresses and interrupts are default settings and recommended

respectively.
m
PCI/PNP ISA IRQ Resource Exclusion Item Specific Help
| Available]]
IRQ 4: [Available] Reserves the specified
IRQ 5: [Available] IRQ for use by legacy
IRQ9: [Available] ISA devices

IRQ 10:  [Available]
IRQ 11:  [Available]
IRQ 12:  [Available]

F1 Ay +/— F9
ESC “«> Enter F10

Fig. 5-13 "PCI/PNP ISA IRQ Resource Exclusion” Submenu

IRQ Available IRQ can be assigned by the BIOS Plug&Play

mechanism to Plug and Play modules or to basic
board functions.

Reserved Must only be set if the respective interrupt is not to
be specifically assigned to a Plug & Play
PCMCIA module.

SIMATIC Power PG Manual
5-18 A5E00097462-02



Configuring the SIMATIC Power PG

“PCI IRQ line” Field

m

PCI Configuration Item Specific Help

PCI devices can use

» PCI/PNP ISA Resource Exclusion hardware interrupts cal-
led IRQs. A PCI device

. cannot use IRQs already
PCI IRQ line 1: — Pt Sl in use by ISA or EISA de-
PCI IRQ line 2: vices. Use 'Auto’ only if
PCI IRQ line 3: no ISA or EISA legacy
PCI IRQ line 4: cards are installed
F1 +/—

ESC Enter

Fig. 5-14 "PCI Configuration” submenu

Disabled No interrupt possible for this PCI-IRQ line

AutoSelect Plug and Play mechanism in BIOS selects unassigned interrupts and
allocates them to the on-board PCI devices.

3to 15 The PCI-IRQ line is assigned to the selected interrupt.
Do not use this setting unless it is specifically required in your application
documentation.

Assignment of the PCI IRQ lines to the PCI slots.

Power PG PCI Module Interrupt Assignment (PCI-IRQ) in:
Module Interrupt (Pin No.) | Slot 1 Slot 2
INT — B (B7) line 2 line 3
INT — C (A7) line 3 line 4
INT — D (B8) line 4 line 1

gray highlighting indicates slot module main interrupt

SIMATIC Power PG Manual
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5.4

5-20

The Security Menu

You can only edit the fields enclosed in square brackets. Two passwords are
assigned to protect your programming device from unauthorized use. You can use
the supervisor password to prevent use of diskettes for the normal user and to limit

use of the hard disk.

Main Advanced Security Power Boot Sequence  Version  Exit
Item Specific Help
Supervisor Password is: Disabled
User Password is : Disabled Select the operating
system installed
Set User Password [ Enter ] on your system which
| Enter]| you will use most
commonly.
. Note: An incorrect
Password on boot: [Disabled] setting can cause
some operating
systems to displa)
Fixed disk boot sector: [Normal] u)rlmexpected be'?la\)/lior.
Diskette access: [Supervisor]
=1 4y +/— F9
ESC > Enter F10

Fig. 5-15

"Security” Menu

Supervisor/
User Password is

Enabled Password is active. BIOS Setup cannot be opened
until the password has been entered.
Certain Setup fields are thus configurable by the

user, including the user password.

The field resets automatically from [Disabled] to [Enabled] when
the password is entered.

Set User Password

This field opens the dialog box for entering a password. Once it
has been entered correctly, the user password can be changed
or deleted by pressing "Return” and thus deactivated.

Set Supervisor Pass-
word

This field opens the dialog box for entering a password. Once it
has been entered, the supervisor password can be changed or
deleted by pressing "Return” and thus deactivated.

Password on boot [Disabled] No password required for system boot.
[Enabled] Supervisor or user password must be entered for
system boot.
Fixed disk boot sector | [Normal] All types of hard-disk access are permitted.

[Write Protected]
No operating system can be installed.
This is a way of protecting against boot viruses.
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Diskette access This mode of protection is not active unless "Password on boot ”
is set to [enabled].

Supervisor  Diskette access is not possible unless the
supervisor password was entered during
system boot.

User Diskette access is not possible unless the
user password was entered during system boot.

SIMATIC Power PG Manual
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5.5

5-22

The Power Menu

Main Advanced Security Power Boot Sequence  Version Exit
APM: [Enabled] Item Specific Help
[Disabled|]
. APM (Advanced Power
Standby Timeout: [Off ] Management) allows APM
y e to manage
Hard Disk Timeout: [Disabled] DI s pilflenablec
Resume On Time [On]
Resume Time [00:00:00] _
After Power Failure: [Last State] Not valid for ACPI
Operating Systems
F1 Ay +/ - [=°)
ESC > Enter F10

Fig. 5-16

“Power” Menu

The “Power” menu allows various power saving modes to be set. These settings
apply only for “legacy” power management. ACPI operating systems can overwrite

these settings.

Notice

The settings in this menu are only valid if no ACPI operating system is used.

APM [Enabled] The operating system can shut down system
(Advanced Power resources when they are not needed.
Management) [Disabled] The operating system is denied APM access.
Power Savings [Disabled] No power-saving functions

[Customize, Maximum Power Savings, Maximum Performance]

User-selectable and preset power-saving
functions for maximum and minimum power
saving.

You can set the parameters for Standby
Timeouts and Fixed Disk Timeout

or they set automatically to their defaults.

SIMATIC Power PG Manual
A5E00097462-02




Configuring the SIMATIC Power PG

Standby * [Off] No standby mode

Timeout [30 seconds or ...minutes after your PC enters standby
mode. 1,2,4,8,12,16]

Hard Disk Timeout [Disabled] The hard disk does not shut down.

[10, 15, 30, 45] Seconds or

[1, 2, 4, 6, 8, 10, 15] Minutes since the last hard-disk access,
the hard disk is shut down.
The next time it is accessed, the hard disk
starts spinning again after a brief delay.

Resume On Time

[On] If this function is enabled the
programming device is automatically
switched on at the preset time.

[Off] 'Off’ means this function is disabled.

Resume Time

Time for automatic restart

After Power Failure

[Stay Off] After power failure the device is not switched
on automatically.

[Last State] Provided it was switched on prior to a power
failure, the device is switched on again

[Power On] Restores the previous power state before

loss occured.

* Can only be set, if Power Savings is set to “Customized” .
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5.6

5-24

The Boot Sequence Menu

This menu allows you to set the priority of boot devices.

Main Advanced Security Power Boot Sequence Version Exit

Item Specific Help

+Hard Drive Keys used to view or
CD-ROM Drive configure devices:
Intel0 Boot Agent <Enter> expands or
collapses devices with
a+or—

<Ctrl+Enter> expands
all

<+>and <—> moves
the device up or down.

F1 Ay +/— F9
ESC “«> Enter F10
Fig. 5-17 “Boot Sequence” Menu

This menu lists the boot devices in groups. The group with the highest priority is at
the top. The procedure for changing the sequence is as follows:

Use the 11 keys to select a group and the + or - keys to move the group to its
new position in the sequence.

Note

During booting the boot drive can be selected with the ESC key. Intel® Boot
Agent is only displayed if, beforehand, the LAN Remote Boot function has been
set to “Enabled” in the hardware options menu.
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Groups marked + can contain more than one device. When you select a group

marked in this way, hit Enter to view the list of devices in the group. See the figure

below for an illustration:

Main Advanced Security

Power

Boot Sequence

Version Exit

LS-120 SLIM4 00—(SM)
—Hard Drive

Alternate Device
CD-ROM Drive
Inteld Boot Agent

FUJITSU MPG3204AT E—(PM)

Item Specific Help

Keys used to view or
configure devices:
<Enter> expands or
collapses devices with
a+or—

<Ctrl+Enter> expands
all

<+>and <—> moves
the device up or down.

F1
ESC :

v+

+/ -
Enter

F9
F10

Fig. 5-18 The “Boot Sequence” Menu

This screen shows all possible boot devices; within a given group the highest

priority device is always listed first. Here again, you can change the sequence as

described above.

If a boot device is not available, the next device in the sequence is automatically
checked to ascertain whether or not it is bootable.
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5.7

5-26

The Version Menu

This menu contains the information you will have to quote when you send us

technical questions about your system.

Main Advanced Security

Power

Boot Sequence Version Exit

SIMATIC PG

Bios Version
Bios Number

MPI/DP Firmware
ProgAS Firmware

IR-Receiver Firmware
IR-Transm. Firmware

CPU Type
CPU Speed
CPU ID

Code Revision

Power PG

V10.02.xx

AS5E000XXXXX—ESxXx

Vxx
VXX

Vxx
VXX

Pentium(R) 1l

866 MHz
0686
0008

Item Specific Help

All items on this menu
cannot be modified in
user mode. If any
items require changes,
please consult your
system Supetrvisor.

F1 4y
ESC “«>

+/ -
Enter

F9
F10

Fig. 5-19

The “Version” Menu
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5.8 The Exit Menu

The setup program is always terminated using this menu.

Main Advanced Security Power  Boot Sequence Version Exit

Item Specific Help

Exit Without Saving Changes
9 g Exit System Setup and

Get Default Values
) save your change to
Load Previous Values CMOS.

Save Changes

F1 4y +/— F9
ESC “«» Enter F10

Fig. 5-20 The “Exit” Menu

Save Changes & Exit All changes are saved; a system restart is carried out with the

new parameters.

Discard Changes & Exit All changes are rejected; a system restart is carried out with
the previous parameters.

Get Default Values All parameters are set to safe values.
Load Previous Values The last saved values are reloaded.
Save Changes Save all Setup settings.
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Error Diagnostics

What Does This Chapter Contain?

6

This chapter will help you to locate, identify, and in some cases eliminate simple

errors and faults.

Error/Fault

Remedy

Device LED does not light up

PG is switched off
Power supply not properly connected

Press the Power Button

Check the power supply, power cable, and
power plug

External monitor remains dark

LCD enabled is entered in SETUP

Enter CRT enabled or SIMULTANEOUS in
SETUP

Message on the Display :"Invalid configurati
tinue, F2 to run Setup utility”

on information... Press the F1 key for con-

Configuration data not correct

Hit the “F2” key, check the configuration data
in the SETUP program, if necessary adapt
the default values, check the error messages
in the first SETUP menu

data carrier

Message on the Display "No boot device available” NTLDR not found, check boot

No bootable disk in drive A:

Wrong hard disk type entered in SE-
TUP

Replace the disk with a boot disk
Use the “Autodetect Fixed Disk” function

Message on the Display : "Keyboard stuck key failure”

A key became blocked during the self-
test of the keyboard

Check the keyboard. Restart the system if
need be.

Every time a key is pressed, a beep is heard and no characters are displayed

Keyboard buffer overflow

<CTRL> <PAUSE>

<\ > key does not exist

Wrong keyboard driver

German keyboard: <ALTGr> <3>
International keyboard : <\> key

SIMATIC Power PG Manual
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Entered characters are not transmitted correctly by the keyboard

» Transmission path is faulty » Align the keyboard better to the device
LED for keyboard transmission status
flashes red

» Battery set in the keyboard is dischar- |+ Replace the battery set or connect the keybo-
ged ard via the emergency cable to the USB port
LED for keyboard transmission status
lights up red « Assian keyboard ID correctly (see Section

» Keyboard and device have different 2.2.1)
identifications

SIMATIC Power PG Manual
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7.1 System Resources

All system resources (hardware address, memory configuration, IRQ,

DMA channel) are assigned dynamically by the Windows OS, depending on the
hardware configuration, drivers and connected peripheral devices. You can view
the current configuration of system resources or possible conflicts with the
following operating systems:

Windows Me

Start > Programs > Accessories > System Tools > System Information

Windows 2000

Start > Settings > Control Panel > Administrative Tools > Computer
Management > System Information

SIMATIC Power PG Manual
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7.2 Interface Pinout

USB

Both interfaces are conceived for high-current USB (500mA). However, they
cannot be used simultaneously as high-current interface. The connectors are of

Type A.
V=
1| [P
3
<,
j/
Pl p ¢
Y >>& .
Pin-No. | Designation Description Input / Output
1 VCC +5V (fused) Output
2 - Data Data line Input / Output
3 + Data Data line Input / Output
4 GND Ground -
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VGA

15-pole socket for an external monitor. Pinout:

Pin No. | Designation Description Input/Output
1 R Red Output
2 G Green Output
3 B Blue Output
4 - Unassigned -
5 GND Ground -
6 GND Ground -
7 GND Ground -
8 GND Ground -
9 - Unassigned -
10 GND Ground -
11 - Unassigned -
12 DDC_DAT Display Data Channel Data Input / Output
13 EXT_H Horizontal synchronizing Output
pulse
14 EXT_V Vertical synchronizing pulse Output
15 DDC_CLK Display Data Channel Clock | Input/ Output

7-4
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MPI/DP

Pinout of the MPI/DP socket:

Pin No.

Designation

Description

Input/Output

Unassigned

Unassigned

LTG_B

Signal line B of MPI module

Input/output

ArlWIN

RTS_AS

RTSAS, control signal for received data
stream. The signal is “1” active when the
directly connected programmable controller is
sending.

Input

MSEXT

MS5EXT return line (GND) of the 5 V power
supply. The current load caused by an
external user connected between P5EXT and
M5EXT must not exceed the maximum of

90 mA.

Output

PS5 EXT

P5SEXT power supply (+5 V) of the 5 V power
supply. The current load caused by an
external user connected between P5EXT and
M5EXT must not exceed the maximum of

90 mA.

Output

Unassigned

LTG_A

Signal line A of the MPI module

Input/output

RTS_PG

RTS output signal of the MPI module. The
control signal is “1” when the programming
device is sending.

Output

Screen

on connector casing
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Ethernet, RJ45 Connection

7-6

Pinout of the Ethernet interface:

LED yellow LED green
] L]
[]
1 8
Fig. 7-1 Ethernet port
Pin-No. Designation Description Input / Output
1 TD+ Transmitted data Output
2 TD- Transmitted data Output
3 RD+ Received data Input
4,5 * SYMR Internal 75 Q output -
6 Received data Input
7,8 * SYMT Internal 75 Q output -
S Shield -
LED yellow Connection -
LED green Activity -

* is not necessary for data transfer
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LPT1 Parallel Port
The parallel port (LPT 1) has the following pinout:

=

=
i

(CNONONONONONONONONONONONO)
(ONONONORONORONORORORONO),

fi

w
N
al

i

Fig. 7-2 LPT 1 Parallel Port (Socket)

Pin No. | Designation Description Input / Output

1 / Strobe (CLK) Data message Output (open collector)
2 Data - Bit 0 Data line O Output (TTL level)

3 Data - Bit 1 Data line 1 Output (TTL level)

4 Data - Bit 2 Data line 2 Output (TTL level)

5 Data - Bit 3 Data line 3 Output (TTL level)

6 Data - Bit 4 Data line 4 Output (TTL level)

7 Data - Bit 5 Data line 5 Output (TTL level)

8 Data - Bit 6 Data line 6 Output (TTL level)

9 Data - Bit 7 Data line 7 Output (TTL level)

10 /ACK Acknowledge Input (4.7 kQ pull up)
11 BUSY Not ready Input (4.7 kQ pull up)
12 PE No paper Input (4.7 kQ pull up)
13 SELECT Device selection Input (4,7 kQ pull up)
14 / AUTO FEED Automatic new line Output (open collector)
15 / ERROR Device error Input (4,7 kQ pull up)
16 /INIT Reset / Initialization Output (open collector)
17 / SELECT IN Printer selection Output (open collector)
18-25 |GND Ground -
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Micro-In
Plug for external microphone. Pinout:
Power ground
3.5-mm microphone plug
Fig. 7-3  Pin assignment of the microphone plug
Headphone

Plug for external headphones. Pinout:

3.5-mm headphone stereo phono plug

Fig. 7-4 Headphone stereo phono plug
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COML (V.24/TTY)

D

(ORONONONONONCHRORONORONONO)

R IORCRORORORORONCRORCRCKC)

=
w

ok

Pin No. | Designation Description Input /Output
1 - Shield -
2 TxD (D1) Serial transmit data Output
3 RxD (D2) Serial receive data Input
4 RTS (S2) Request to send Output
5 CTS (M2) Clear to send Input
6 DSR (M1) Data set ready Input
7 GND (E2) Functional ground -
(reference potential)

DCD (M5) Data carrier detect Input
9 +TTY RxD TTY receive Input
10 -TTY RxD TTY receive Input
11-17 |- Unassigned -
18 +TTY TxD TTY send Output
19 +20mA Isolated current source -
20 DTR (S1) Data terminal ready Output
21 -TTY TxD TTY send Output
22 RI (M3) Incoming call Input
23-25 - Unassigned -

Adapter for COM1

Use the “Serial Port Adaptors D9/D25” to convert your COM1/ V24 / PLC interface

to a common 9-pole pin strip. Just plug the adapter into the COM1 socket and

secure it with the two hex head screws.

The V24 and TTY interfaces for COM1 can be alternately used.
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7.3 Patch Cords

SIMATIC S5 Patch Cord

You can use the SIMATIC S5 cord set (hot included in all delivered versions) to
connect your SIMATIC Power PG to a SIMATIC S5 PLC. Please not the
comments in Chapter 3.

PG side Patch cord PLC side
25-pole pin strip 6ES5 734-2BD20 15—-pole pin strip

active \ (included in the consignment)  passiv
(7 330 Ohm e - /
| —

19 3 95— Ef
= B

— -»>
}+ E—( 18 2 > -
| hd

21 [ [
-V

330 Ohm i
+V 19 { ¢ 6FF<{
3
— —C 9 7>+ —
?'f[ :
<
| H 10

-V

Housing 1 ——

8 Shielding/
€3 ::l 1 Housing

—<C 20

Fig. 7-5 SIMATIC S5 Standard Cord Set

MPI/DP Cord Set for SIMATIC S7

You can use the 6ES7901-0BF00-0AAQ cord set to connect your
SIMATIC Power PG to a SIMATIC S7 PLC. Please not the comments in Chapter
3.
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Reinstallation of the Software

What Does This Chapter Contain?

This chapter explains how to resinstall the software if the pre-installed software
contains errors.

Chapter Overview

Section Description Page
8.1 Cause / Remedy 8-2
8.2 Restoring the Hard Disk (Data Deleted) 8-3
8.3 Installing the Operating System Windows Me 8-7
8.4 Installing Drivers under Windows Me 8-8
8.5 Installing the Operating System Windows 2000 8-9
8.6 Installing Drivers under Windows 2000 8-12
8.7 Installing the SIMATIC-Software 8-14
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Reinstallation of the Software

8.1 Cause / Remedy

In case of software errors, reinstall your software using the Recovery CD and the
“Backup PG” CD.

To restore all directories and files that were copied to your hard disk after the first
set up proceed as follows:

1. Ifitis possible to save your authorization proceed as described below.

2. If itis not possible to save your authorization please contact the customer
support hotline (see Getting Started). They will provide you with the information
necessary for your authorization.

Then proceed as described in Section|8.2.

Saving Authorization on Diskettes
Please proceed as follows:
* Insert authorization disk in drive A:
* Click "Start” on the Windows task bar and

» Select Simatic > AuthorsW > AuthorsW to open the authorization tool which
will help you to save all authorizations on your authorization disk.

SIMATIC Power PG Manual
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8.2

8.2.1

Restoring the Hard Disk (Data Deleted)

Creating Partitions under Windows Me

After installing a new hard disk it is necessary to create partitions with the program
“FDisk” when the partitions have errors or need to be changed.

Caution

By deleting or creating partitions or logical DOS-hard drives all saved data is lost
on the hard disk. All drives on the hard disk will be erased.

The hard disk is delivered with the following installed (only for versions delivered
with Windows Me):

— a FAT32 PRI DOS partition with 6100 MB,
— a FAT32 EXT DOS partition.

Information on the FAT32 file system can be found in the manual “Getting Started
with Microsoft Windows Me”.

To restore the partitions to their original condition, please do the following:

Primary Partition

1. To boot from the Recovery CD, hit the ESC key when the BIOS message
Press <F2> to enter Setup

appears on-screen. After initialization a boot menu opens in which you can
select the boot options.

2. Select “ATAPI CD-ROM Drive”.

3. When “Microsoft Windows 98 Startup Menu” is displayed, select
“2. Boot for FDISK, FORMAT or Windows Me Setup”.

4. Start the Microsoft Windows Me hard disk configuration program with
"A:\>FDisk” .
In the dialog box, select “Yes” in “Activate Support (Y/N)...? [ Y]” to enable large
disk support for FAT32 partitions.

5. Create a primary DOS partition with at least 4090 MB. For FAT32 patrtitions,
enter [N] for “No” for the question "Do you want to use the maximum memory
size available for the primary DOS partition and do you want to activate this
partition?” and set the partition size, for example, to 6100 MB.
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Creating an Extended Partition

8.2.2

In order to create an extended patrtition, you have to first boot from the Recovery
CD as described in steps 1 to 3 above.

Using "A:\>FDisk” start the Microsoft Windows Me hard disk configuration
program.

Select the dialog box for large disk support. “Do you wish to enable large disk
support (Y/N)...? [Y] for Yes.

Create an extended DOS patrtition for the rest of the disk space.

Creating Partitions under Windows 2000

After installing a new hard disk it is hecessary to create partitions if the partitions
contain errors or need to be changed.

Caution

All stored data is lost when you delete or create partitions. The hard disk partitions
will be erased.

The hard disk is partitioned on delivery as follows (only for versions delivered with
Windows):

— one partition with the FAT32 file system with at least 6100 Mbytes,
— one partition with the NTFS file system.

To restore the partition to its delivery state, proceed as follows:

Primary Partition, FAT32 File System

8-4

1. Boot from the Recovery CD and press ESC when the BIOS message
Press <F2> to enter Setup
appears. After initialization, select the boot options in the boot menu.

2. Select "ATAPI CD-ROM Drive”.

3. Select "2. Boot for FDISK, FORMAT or Windows 98 Setup” in the "Microsoft
Windows Startup Menu” screen form.

4. Start the Microsoft Windows hard disk configuration program with "A:\>FDisk”.
In the screen form select “Do you wish to enable large disk support (Y/N)...?
[ Y ] for Yes to support data media with large memory capacity.

5. Create a primary DOS patrtition with 4090 MB. Enter [N] for “No” for the
guestion "Do you want to use the maximum memory size available for the
primary DOS partition and do you want to activate this partition?” and set the
partition size to 6100 MB.
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6. To format the partition from the Recovery CD, as described above in steps 1 to
3, reboot and then format drive C: with the “Format” program. Enter:
"A:\>Format C:"

(A: is the CD-ROM drive).

Creating an Extended FAT 32 Partition

8.2.3

In order to create an extended partition you have to boot from the Recovery CD as
described above in steps 1 to 4.

Create an extended DOS patrtition for the rest of the disk space.

In the Windows 2000 setup or under Windows 2000 the FAT 32 file system can be
converted to an NTFS file system with the “Format” function.

Creating Partitions under Windows NT

After installing a new hard disk it is necessary to create partitions when they
partitions have errors or need to be changed.

Caution

By deleting or creating partitions all saved data is lost on the hard disk. All drives
on the hard disk will be erased.

The hard disk is delivered with the following installed (only for versions delivered
with Windows NT):

— a partition of with the FAT16 file system with 2045 Mbytes,
— a partition of with the NTFS file system.
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To restore the partitions to their original condition, please do the following:

Primary Partition

8-6

1. To boot from the Recovery CD proceed as follows: When the message
Press <F2> to enter Setup

appears on the screen press the ESC key. After initialization a boot menu to
select the boot options is displayed.

2. Select “ATAPI CD-ROM Drive”.

3. When “Microsoft Windows 98 Startup Menu” is displayed, select
“2. Boot for FDISK, FORMAT or Windows NT Setup”.

4. Start the Microsoft Windows 98 hard disk configuration program with
"A:\>FDisk” (A is the CD-ROM drive).
Select the dialog box for enable large disk support for installing a FAT16
partition “activate support (Y/N)...? [ N]” for No.

5. Create a primary DOS-Partition of 2045 MB for a FAT 16 file system. Answer
the question “Do you wish to use the maximum available size...” for a 2045 MB
FAT16 partition with [Y] for Yes.

6. In order to continue with the next step “Create a Save to Disk Partition” the
primary partition needs to be formatted.
Use the Recovery CD to boot as described in steps 1 to 3 above and then
format drive C: with the program “Format”.
Type: "A:\>Format C:".

The creation of NTFS partitions is done under the Windows NT setup program.
Starting the Windows NT setup is described in chapter 8.6.
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8.3 Installing the Operating System Windows Me

You should only follow these steps when you wish to upgrade from Windows
2000/NT to Windows Me or if you reinstall Windows Me.

The operating system can be reinstalled or restored using the “Recovery CD".

This CD contains encoded data which can only be transferred onto a
SIEMENS SIMATIC programming device.

Data transfer is carried out with the OEMSETUP.EXE program on the CD-ROM or,
after booting, from the CD-ROM with the Recovery function.

After transferring the required data to the hard disk, the operating system can be
installed using the Windows Me setup program. The Windows Me setup can be
started by entering:

HD:A\>WIN9X\SETUP.EXE

(HD: drive on which the WINME folder was transferred to).

Windows Me Installation Sequence

If a Windows operating system is already installed or if the programming device
has been started with a bootdisk, data transfer is executed using the program
OEMSETUP.EXE. To do this, start the program OEMSETUP.EXE on the recovery
CD and continue the sequence as of point 5.

If there is no operating system installed, then please do the following:
1. Insert the recovery CD in the CD-ROM drive and switch on the PLC.

2. To boot from the recovery CD proceed as follows: When the message
Press <F2> to enter Setup

appears on the screen press the ESC key. After initialization a boot menu to
select the boot options is displayed.

3. Select “ATAPI CD-ROM Drive”.

4. When the “Microsoft Windows 98 Startup Menu” is displayed, select
“1. Boot for CD-Recovery”.

5. You have to confirm the “SIEMENS End User License Agreement” with the F8
function key. Pressing ESC allows you to decline the agreement and cancels
the installation.

6. In the next screens you can select the components which are to be copied from
the CD to the hard disk. Transfer of at least the folder “WIN9x” is necessary for
the Windows Me installation or setup.

7. A selection of disk drives for the data transfer is next offered. The disk drive
selected is not the installation drive for Windows. It is the drive on which the
necessary installation files and extensions are saved. You need approximately
250 MB of additional memory for the Windows setup following the transfer.
During a standard installation Windows Me is installed on drive C:. Therefore,
please make sure when selecting a drive that there is enough available memory
on drive C: after the data transfer.
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8.3.1

Procedure

8.4

8-8

8.

You can start the Windows Me setup after the data transfer and after having
confirmed the completion prompt via the program

HD:AWIN9X\SETUP.EXE

(HD: drive on which the folder WIN9x was transferred to).

Installing Drivers under Windows Me

In order to add or change the device driver of any hardware component proceed as
follows:

Open the dialog box “System Properties”, Click “Start” , point to “Settings”, click
“Control Panel” , then double-click “System” .

Click the “Device Manager” tab, click on the plus sign next to the hardware type
and then double-click on the selected hardware component.

Click the “Driver” tab and then click “Update Driver”, then follow the instructions
that appear on your screen.

The “Driver” tab may not be available for some devices. In this case try to
change the driver by double-clicking on the desired hardware icon in the
“Control panel”.

Installing Drivers and Software

Installieren the drivers and software from the supplied CD "Backup PG”. Proceed
as follows:

1.

Insert the CD

. Acrobat Reader must be installed

2
3.
4

Navigate through the driver list to ../Drivers/PowerPG.pdf

. Install the desired driver according to the Driver List.
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8.5 Installing the Operating System Windows 2000

Do not follow these instructions unless you want to upgrade from Windows Me/NT
to Windows 2000 or if you want to reinstall.

The new installation or reinstallation of the operating system is accomplished with
the Recovery CD to a FAT 32/16 partition.

This CD contains encoded files which can only be transferred to a
SIEMENS SIMATIC programming device.

The transfer of information is made with the program OEMSETUP.EXE on the
CD-ROM, or after booting from the CD-ROM with the recovery function.

The installation of the operating system via the Windows 2000 setup program is
possible after transferring the necessary data to the hard disk. The Windows 2000
setup starts when you enter

HD:\>i386\WINNT.EXE

(HD: drive on which the folder 1368 was transferred to).

Setup for Windows 2000 can be carried out on existing Windows installations via
the program HD:\i386\WINNT32.EXE.

Windows 2000 Installation Sequence

If a Windows operating system is already installed or if the programming device
has been started with a bootdisk, the transfer of the data takes place using the
program OEMSETUP.EXE. To do this, start the program OEMSETUP.EXE on the
recovery CD and continue the sequence as of point 5.

If there is no operating system installed, then please do the following:

1. Insert the recovery CD in the CD-ROM drive and turn on the programming
device.

2. To boot from recovery CD, press the ESC key at the BIOS message:
Press <F2> to enter Setup
After completing the initialization a boot menu screen appears in which you can
select the device to be booted from.

3. Select “ATAPI CD-ROM Drive”.

4. Select “Boot for CD-Recovery” in the screen "Microsoft Windows 98 Startup
Menu”.

5. You have to confirm the “SIEMENS End User License Agreement” with the F8
function key. Pressing ESC allows you to decline the agreement and cancels
the installation.

6. In the next screens you can select the components which are to be copied from
the CD to the hard disk. At the very least it is necessary to copy the folder
“1386” to install or setup Windows 2000.
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7. A selection of disk drives for the data transfer is next offered. The disk drive
selected is not the installation drive for Windows. It is the drive on which the
necessary installation files and extensions are saved. You need approximately
500 MB of additional memory for the Windows setup following the transfer.
During a standard installation Windows 2000 is installed on drive C:. Therefore,
please make sure when selecting a drive that there is enough available memory
on drive C: after the data transfer.

8. You can start the Windows setup after the data transfer and acknowledgment of
the completion message via the program
HD:\I386\WINNT.exe
(HD: drive on which the folder 1368 was transferred to).
If a Windows operating system already installed, you can start the Windows
2000 setup after starting Windows via the program
HD:\I368\WINNT32.exe.

Choosing the Language for Windows 2000

8-10

The Multilanguage User Interface (MUI) allows you to set the Windows 2000
menus and dialogs to another language.

In order to install the MUI, run the program MUISETUP.EXE in the
CD_DRIVE:\MUI folder on the Recovery CD and follow the screen dialog to install
the desired languages.

The desired language for Windows 2000 menus and dialogs, as well as the
keyboard layout can be set via the control panel with the dialog Start > Settings >
Control Panel > Regional Options > tab “General” > box “Menus and
dialogs” and in the tab “Inputs” , box “Keyboard layout”

In addition to the language for menus and dialogs, you can also set via Regional
Options the standard for the region with Set Default .

Your device is set to English menus and dialogs and a US keyboard when
delivered. You can set another language and keyboard via the control panel with
the dialog Start >Settings > Control Panel > Regional Options > tab "General ",
box "Menus and dialogs”> tab "Input locales”, box "Input language”
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8.5.1 Installing Drivers under Windows 2000

In order to add or change the device driver of any hardware component proceed as
follows:

Procedure
» Click “Start” , point to “Settings”, click “Control Panel” , then double-click
“System” .
» Click the “Device Manager” tab, click on the plus sign next to the hardware type
and then double-click on the selected hardware component.

» Click the “Driver” tab and then click “Update Driver”, then follow the instructions
that appear on your screen.

» The “Driver” tab may not be available for some devices. In this case try to
change the driver by double-clicking on the desired hardware icon in “Control
panel”.
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8.6

Installing the Operating System Windows NT

Installation of the Recovery CD in Microsoft Windows NT

8-12

This CD contains encoded data which can only be transferred onto a
SIEMENS SIMATIC programming device.

Data transfer is carried out with the OEMSETUP.EXE program on the CD-ROM or,
after booting, from the CD-ROM with the Recovery function.

After transferring the required data to the hard disk, the operating system can be
installed using the Windows NT setup program.

Windows NT Installation Sequence

If a Windows operating system is already installed or if the PC has been started
with a user created bootdisk, the transfer of the data takes place using the
program OEMSETUP.EXE. To do this, start the program OEMSETUP.EXE on the
recovery CD and continue the sequence as of point 5.

If there is no operating system installed, then please do the following:
1. Insert the Recovery CD and reboot the system.

2. To boot from the CD proceed as follows: When the message
Press <F2> to enter Setup

appears on the screen press the ESC key. After intialization a boot menu to select
the boot options is displayed.

3. Select "ATAPI CD-ROM Drive”.

4. When “Microsoft Windows 98-Startup Menu” is displayed, select
“1. Boot for CD-Recovery”.

5. You have to acknowledge the “SIEMENS End User License Agreement” with
the F8 function key. Pressing ESC allows you to decline the agreement and
cancels the installation.

6. In the next screens you can select the components which are to be copied from
the CD to the hard disk. Transfer of at least the folder “I386” is necessary for
the Windows NT installation or setup.

7. Select the drive for data transfer. You can use the selected drive as the
installation drive for Windows. For the Windows setup, you need an available
disk space of approximately 300 MB on the installation drive for Windows.

Caution
By default, drive C: is used for the data transfer (Recovery).

Ensure that there is an available disk space of approximately 300 MB left on drive
C: after the selected recovery data have been copied.
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8. Confirm the end massage box.

9. Start the Windows setup program
LW:\I386\Winnt.exe
LW is the drive where the recovery data have been copied.

You can find the information on installation of Windows NT on the Recovery CD in
the folder SUPPORT\BOOKS\.

Note

If you want to become an expert user of Microsoft Windows NT Workstation, see
the “Windows NT Workstation Resource Kit” Version 4.0 (is not included in the
package). It contains specific information for administrators who are responsible
for installing, managing, and integrating Windows NT Workstation in a network or
multiuser environment.
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8.7

8-14

Installing the SIMATIC Software

You received the “Backup PG” CD with the product package that comes with your
SIMATIC Power PG. The Backup CD contains the data base for the installed
SIMATIC program package as well as the PG’s electronic manuals.

To reinstall these program packages, insert the CD “Backup PG” in the CD-ROM
drive. Run Setup by clicking the “ SIMATIC Setup” icon or by clicking “Setup.exe”
in the “SIMATIC Software” directory. Setup will guide you through the installation.

The authorization diskette with the authorizations necessary for the use of
SIMATIC software is only delivered with versions containing the corresponding
SIMATIC software.

The installation of the authorizations is described in Section'3.3.1/“Cold Start of the
PG”.
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Guidelines for Handling Electrostatically-Sensitive Devices (ESD)

Al

Definition

What is ESD?

All electronic modules are equipped with large-scale integrated ICs or components.
Due to their design, these electronic elements are very sensitive to overvoltages
and thus to any electrostatic discharge.

These Electrostatically-Sensitive Devices are commonly referred to by the
abbreviation ESD.

Electrostatically-sensitive devices are labeled with the following symbol:

Caution

Electrostatically-sensitive devices are subject to voltages that are far below the vol-
tage values that can still be perceived by human beings. These voltages are pre-
sent if you touch a component or the electrical connections of a module without pre-
viously being electrostatically discharged. In most cases, the damage caused by an
overvoltage is not immediately noticeable and results in total damage only after a
prolonged period of operation.
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A.2 Electrostatic Charging of Persons

Charging
Every person with a non-conductive connection to the electrical potential of its
surroundings can be charged electrostatically.

Figure A-1 shows you the maximum values for electrostatic voltages which can
build up on a person coming into contact with the materials indicated in the figure.
These values are in conformity with the specifications of IEC 801-2.
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Fig. A-1 Electrostatic Voltages which can Build up on a Person
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A.3 General Protective Measures Against Electrostatic
Discharge Damage

Ensure Sufficient Grounding

Make sure that the personnel, working surfaces, and packaging are sufficiently
grounded when handling electrostatically-sensitive devices. You thus avoid
electrostatic charging.

Avoid Direct Contact

You should touch electrostatically-sensitive devices only if it is unavoidable

(for example, during maintenance work). Hold modules without touching the pins of
components or printed conductors. In this way, the discharged energy cannot
affect the sensitive devices.

If you have to carry out measurements on a module, you must discharge your
body’s electrostatic charge before you start the measurement by touching
grounded metallic parts. Use grounded measuring devices only.
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Note

At the start of the PG the BIOS messages (Summary Screen) offer a precise over-
view of your SIMATIC Power PG configuration
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Technical Specifications

General

Dimensions (w x h x d)

392 x 321 x 130 mm

Weight

approx. 8 kg

Line voltage external power supply

100 VAC to 240 VAC (+ 10% / — 15%)

Line voltage frequency

50 / 60 Hz (47 to 63 Hz)

Brief voltage interruption acc. to Namur

> 20 ms at 93V (AC power supply)

(max. 10 times per hour; min. recovery time 1 s)

Max. AC power consumption

Approx. 180 W

Degree of protection

IP30 (covers closed)

Quality assurance

1ISO 9001

Safety

Requirements

VDE 0805 ~ EN 60950 and IEC 60950
Protection class | to IEC 60536

Protective separation between supply and secondary circuit
(via external power supply)

Noise emission

<45 dB(A) to DIN 45635

Electromagnetic compatibility (EMC)

Emitted interference

limit value class B to EN 55022, EN 6100-3-2,

Line-fed interference on AC supply lines

+2kV (IEC 61000-4-4; burst)
+1kV (IEC 61000-4-5; us pulse/line to line)
+2 kV (IEC 61000-4-5; us pulse/line to ground)

Noise immunity on signal lines

+2 kV (IEC 61000-4-4; burst; length >3 m)

+2 kV (IEC 61000-4-5; us pulse/line to ground;
length > 20 m)

Noise immunity to discharges of static
electricity

+4kV, Contact discharge (IEC 61000-4-2; ESD)
+ = kV, Air discharge (IEC 61000-4-2; ESD)

Immunity to RF interference

10 V/m, with 80% amplitude modulation at 1 kHz,
9 kHz - 80 MHz (to IEC 61000-4-6)

10 V/m with 80% amplitude modulation at 1 kHz,
80 kHz - 1GHz (to IEC 61000-4-3)

10 V/m, pulse modulated 50% duty cycle, 900MHz and
1,89 GHz (to IEC 61000-4-3)

Magnetic field

30 A/m, 50Hz (to IEC 61000-4-8)

Ambient conditions

Temperature
operation
storage/transport

tested to DIN IEC 60068-2-1, DIN IEC 60068-2-2
+50 C to +40° C *(no condensation permitted)
— 20° C to +60° C**(no condensation permitted)
(*10° C/h, ** 20° C/h)

Relative humidity

operation

storage/transport

tested to DIN IEC 60068-2-3, 60068—2—30, 60068—2—-14
5% to 80% at 25° C (no condensation permitted)
5% to 95% at 25° C (no condensation permitted)
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Mechanical specifications

Vibration

operation *)

tested to DIN IEC 60068-2-6

10 to 58Hz; amplitude 0.035 mm
58 to 500Hz; acceleration 5 m/s?

operation *)
storage

transport 5to 9Hz; amplitude 3.5 mm
9 to 500Hz; acceleration 9.8 m/s?
Shock tested to DIN IEC 60068-2-29

half-sine: 50 m/s2, 30 ms, 100 shocks
half-sine: 250 m/s2, 6 ms, 1,000 shocks

Motherboard

Integrated processor

Intel Mobile Pentium Ill (see BIOS)

Level 2 cache

first level: 16 Kbytes data, 16 Kbytes program

second level: 256 Kbytes (processor dependent)

Main memory

64 Mbytes expandable to max. 512 Mbytes,
(64-bit SO DIMM) (for memory expansion see BIOS)

Extension slots

2 x PCI, max. 170 mm

Max. permissible power consumption per
expansion slot

+3.3V 2A; +5V 2A; +12V 0.3A; 5Vaux 0.05A; -5V 0.05A,
—12V 0.05A

Drives

Floppy disk drive

Standard Floppy disk drive (1.44 Mbytes), Super disk
LS120 or Super disk LS240 drive (see BIOS)

Hard disk drive

2.5” (capacity see BIOS)

Hard disk/CD-ROM controller

IDE (ATA)-33

Optical drive CD ROM (24x) or
DVD ROM (24x CD ROM, 8x DVD) or
DVD ROM/CD RW (24x CD ROM, 8x DVD, 8x CD RW)
(equipment see BIOS)

Graphics

Controller ATl Rage Mobility 128

Graphics memory

8 MB integrated

Resolutions / frequencies / colors

CRT: up to 1280x1024 / 85 Hz / 4 mill. colors or
1600 x 1200/ 75 Hz / 256,000 colors

LCD display

Type TFT (Thin Film Transistor)

Size 308 mm x 232 mm, equivalent to 38 cm (15 in.)
Resolution 1024 x 768 (XGA)

Colors available max. 256 k

Horizontal frequency 37.8 kHz

Vertical frequency 60 Hz

Contrast 100:1

Brightness > 100 cd/m?

Response time

50 / 50 ms (ton / toff)

* Burning operation with DVD-ROM/CD-RW permissible only in undisturbed enviromment.
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Audio
Sound controller Intel 8201BA/BAM AC97
Compatibility Sound Blaster Pro and Microsoft Sound System, meets

PC98 / PC99 and WHQL specifications

Record and playback features

Up to 16-bit stereo 48 kHz sampling rate, full duplex 3D
audio effects and ESFM(TM) music synthesizer

Internal speaker

Max. power output 2 x 0.5 W

Keyboard

Type Standard notebook
Key spacing 19.05 mm

Key stroke 3 mm

Keytops international / German

Integrated pointing device

Touchpad with 2 mouse buttons

Ports

COML/TTY V.24 or TTY (20 mA) active or passive up to 100 m (25-pole
socket), no galvanic isolation

VGA Interface for external monitor (15-pole VGA socket)

LPT1 Parallel port
Connection for printer with parallel port

Cardbus 2 interfaces for PC cards (type |, type Il or type I);

Cardbus controller from TI: PCI 1420

Memory card

Programming interface for SIMATIC memory cards
and S5 memory modules

Micro Memory Card

Interface for Micro Memory Card

MPI/DP 12 port
Transfer rate

Operating mode

Physical interface
Memory address area

IRQ

9—pole sub-D socket
9.6 Kbaud to 12 Mbaud, configurable per software

Galvanically isolated: data line A, B
control line RTS AS, RTS-PG
5V supl voltage (90mA max.)
Grounded: shielding of the DP12 patch cord
RS485, galvanically isolated
0CCO00h...0CC7FFh or ODCO0Oh...0DC7FFh
5, 10, 11 or 15 configurable per software

uSB 2 USB ports
high-current (500mA),
Ethernet RJ45, 10/100 Mbits,

Intel controller: Kinnereth DA82562ET

Headphone and microphone connector

for 3.5—mm phone jack respectively

Function displays

Status LEDs

Caps Lock

Scroll Lock

Num Lock

Battery status

Device status

Access to FD / HD / CR-ROM
S5 Module/Memory Card active
MPI/DP token passing

B-4

SIMATIC Power PG Manual
A5E00097462-02




Glossary

What does This Chapter Contain?

This chapter contains a glossary in which you will find a list of the terminology used
in conjunction with the Siemens range of programming devices and a brief
explanation of each of the terms.
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AC

Alternating Current. Current that changes its direction at regular intervals.

Access Protection

Access to the programs and data of a programming device can be protected by
passwords. The user password or Superuser password can be assigned in the

BIOS Setup.

ACPI
Advanced Configuration and Power Interface enables the operating system to
supervise the power supply of each device connected to the computer. See also:
Power Management.

APM
Advanced Power Management monitors and conserves power on a PC-based
system, particularly a battery—powered laptop computer, by enabling programs to
communicate their power requirements so that the system can route power away
from unused hardware components.

Application
An application is a program which builds directly on, for example, the
MS-DOS/Windows operating system. Applications on your programming device
are, for example, the STEP 5 Basic package, STEP 7, etc.

ASCII-Editor
With an ASCII editor you can edit text files which are stored in ASCII code.

ATA
Advanced Technology Attachment is the official name for the disk drive
interface standard commonly known as Integrated Drive Electronics (IDE). See
also: IDE.

AuthorsW

The authorization can be saved on the aithorization diskette again by the menu
command Start > Simatic > AuthorsW

Authorization Diskette

The authorization disk contains the authorization required by the
re-installation of a software.

SIMATIC Power PG Manual
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Backup

Duplicate of a program, storage medium or database. Created to backup or to
protect irreplaceable data of working copies as a precaution against corruption or
destruction. Some applications automatically create backup copies, while
managing both the current version as well as the previous version that is stored on
the hard disk drive.

Base Memory

Battery

BIOS

The base memory is a part of the main memory. It is 640 Kbytes for all
programming devices. The size is entered in the SETUP menu under the entry
“System Memory” and is not changed even if the memory is extended.

In personal computers, batteries are used as an auxiliary source of power when
the main power is shut off, as a power source for laptop and notebook computers
(rechargeable batteries, such as nickel cadmium, nickel metal hydride, and lithium
ion, are used), and as a method to keep the internal clock and the circuitry
responsible for the part of RAM that stores important system information always
powered up. Strictly speaking, only batteries that are not rechargeable are
classified as batteries.

Acronym for Basic Input/Output System. On PC-compatible computers, the set of
essential software routines that tests hardware at startup, starts the operating
system, and supports the transfer of data among hardware devices.

Boot Diskette

Boot

Booting

Bps

Boot disk that contains a boot sector and an initial loader for the operating system.

Start or restart of the PG. During the boot sequence the operating system is
transferred from the system drive into the main memaory.

Loading operation which transfers the operating system to the main memory.

The speed (in bits per second) with which information is transmitted over a data
link.
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Cache

The cache memory buffers often used data to increase the speed of access. The
computer has two cache levels.

Cardbus interface

This interface is compatible with 32-bit Cardbus Cards with PCI performance
compliant with the PC Card standard.

CD ROM
Compact Disc Read Only Memory. Removable memory for large amounts of data.
Click
Pressing and immediately releasing the left mouse button; selects objects or
triggers commands.
Cold Boot
A startup process that begins with turning on the computer’s power. Typically, a
cold boot involves some basic hardware checking by the system, after which the
operating system is loaded from disk into memory.
COML1 Port
Serial V.24/modem-PLC interface. This interface is suitable for asynchronous data
transmission. It can also be used to connect printers with a serial interface.
COM2 Port

Serial RS-232 interface which can be used to connect a mouse or a printer.

Configuration Files

These are files containing data which define the configuration after booting.
Examples of such files are CONFIG.SYS, AUTOEXEC.BAT and the registry.

Configuration Software

The configuration software updates the device configuration when new modules
are installed. This is done either by copying the configuration files supplied with the
module or by manual configuration using the configuration utility.

Controller

Integrated hardware and software controllers that control the functions of certain
internal or peripheral devices (for example, the keyboard controller).

SIMATIC Power PG Manual
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Cursor

Collective term for mouse pointer and text cursor.

Cursor Control

Keypad on the keyboard for controlling the cursor.

DC

Direct Current. Unidirectional electrical current.

DIMM

Dual Inline Memory Module. Memory RAM chips that are installed on the PCB,
similar to the more common SIMM (Single Inline Memory Module) chips. The
DIMM with its 64-bit data bus architecture has connections on both sides which are
connected to different circuits for processing different instructions. SIMMs,
however, have a 32-bit data bus architecture where all lines are connected to the
same circuit for processing the same instructions. DIMMs can be installed in the
computer as single chip, SIMMs, on the contrary, only in pairs.

Device Configuration

The configuration of a programming device contains information on hardware and
device options, such as memory configuration, drive types, monitor, network
address, etc. The data are stored in a configuration file and enable the operating
system to load the correct device drivers and configure the correct device
parameters.

If changes are made to the hardware configuration, the user can change entries in
the configuration file using the SETUP program.

Disk Drive
The disk drive (floppy disk drive) is used to store programs and data on diskette
(write access) or to load from diskette to the computer (read access).

Diskette
The diskette (floppy disk) is an external data access memory on which all types of
files and programs can be stored. The storage medium is a round magnetic disk in
a plastic cover to protect it from getting scratched.

Display

Flat screen monitor of the PG.
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Dormancy
An energy saving power management mode that shuts down the monitor and hard
disk after all data found in the work memory have been saved to the hard disk
(Save to Disk). The PG will then be shut down.
Double-Click
Pressing and releasing the left mouse button very quickly twice in succession
without moving the mouse. This action is normally to open an object or program.
Drives
Devices for operating rotary disk media (diskettes, hard disk, CDs).
Drivers

These are programs which are part of the operating system. They adapt user
program data to the specific formats required by I/O devices such as hard disk,
printers, and monitors.

Drop-Down Menu

DVvD

EIDE

Glossary-6

In graphics-supported programs, a menu line is positioned on the top edge of the
screen. The menu titles contained in this line can be set either as drop-down or
pull-down menus. Drop-down menus “roll” down as soon as the mouse pointer
passes over a menu title. Pull-down menus only “roll” down when the menu title is
clicked on. Different functions can then be called from these menus by moving the
mouse and clicking on an item in a menu.

Digital Video Disc. A digital video disc can store greater amounts of data  than a
traditional CD. A standard single—layer, single—sided digital video disc can store 4.7
GB of data; a two—layer standard increases the single—sided disc capacity to 8.5
GB. Digital video discs can be double—sided with a maximum storage of 17 GB per
disc. A digital video disc player is needed to read digital video discs; this player is
equipped to read older optical storage technologies.

Enhanced Integrated Drive Electronics. An extension of the IDE standard, EIDE is
a hardware interface standard for disk drive designs that house control circuits in
the drives themselves. It allows for standardized interfaces to the system bus while
providing for advanced features, such as burst data transfer and direct data
access. EIDE accommodates drives as large as 8.4 gigabytes (IDE supports up to
528 megabytes).
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Energy Options

With Energy Options, you can reduce energy consumption of your computer while
it always remains to be ready to use. This function can be configured in Windows
via Settings > Control Panel > Energy Options

EPROM/EEPROM Submodules

Ethernet

These are plug-in submodules with EPROM/EEPROM chips. S5 user programs
can be stored on them. These programmed submodules are then plugged into
specially designed slots in the programmable logic controller.

Local network (bus structure) for text and data communication with a transfer rate
of 10 Mbaud.

Extended Memory

File

Formatting

Memory extensions can be installed in the programming device to increase the
width of the memory.

A complete, named collection of information, such as a program, a set of data
used by a program, or a user-created document. A file is the basic unit of storage
that enables a computer to distinguish one set of information from another.

Formatting divides the memory area on a magnetic data medium into tracks and
sectors. Formatting deletes all the data on a data medium. Every data medium
must be formatted before it is used for the first time.

Function Keys

H

Hard Copy

Function keys can be divided into two different types; the normal function keys
which are assigned a particular function of the computer (for example, delete key),
and programmable function keys (softkeys).

The output of the complete contents of the screen on a printer is called a hard
copy.
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Hard Disk Drive

Hibernate

HMI

HTML

HTTP

Hub

Hyperlink

IDE

Glossary-8

Hard disk drives (Winchester drives) are a form of magnetic disk memory where
the magnetic disks are permanently built into the drive.

See Dormancy .

Human Machine Interface

Hypertext Markup Language is the markup language used for documents on the
World Wide Web. HTML is an application of SGML (Standard Generalized Markup
Language) that uses tags to mark elements, such as text and graphics, in a
document to indicate how Web browsers should display these elements to the user
and should respond to user actions such as activation of a link by means of a key
press or mouse click.

Hypertext Transfer Protocol is the protocol used to carry requests from a browser
to a Web server and to transport pages from Web servers back to the requesting
browser.

In a network, a device joining communication lines at a central location, providing a
common connection to all devices on the network. The term is an analogy to the
hub of a wheel.

A connection between an element in a hypertext document, such as a word,
phrase, symbol, or image, and a different element in the document, another
document, a file, or a script. The user activates the link by clicking on the linked
element, which is usually underlined or in a color different from the rest of the
document to indicate that the element is linked.

Integrated Device Electronics is a type of disk—drive interface in which the
controller electronics reside on the drive itself, eliminating the need for a separate
adapter card.
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Infrarot

Acronym: IR. Having a frequency in the electromagnetic spectrum in the range just
below that of red light. Objects radiate infrared in proportion to their temperature.

Industrial Ethernet

Bus system based on the Ethernet standard. Components of the SIMATIC S5 and
S7 series (programming devices, programmable logic controllers, programmable
control systems) can be networked using Industrial Ethernet NICs.

Interface module

Module for the connection of peripheral hardware.

Interrupt
When the processor receives an interrupt, it suspends its current operations, saves
the status of its work, and transfers control to a special routine known as an
interrupt handler. This routine processes an instruction set to deal with the
particular situation that caused the interrupt. Interrupts can be generated by
various hardware devices to request service or report problems.

Interface

* An interface is the connection between individual hardware elements such as
PLCs, programming devices, printers, or monitors via physical connections
(cables).

* An interface is also the connection between different programs, to enable them
to work together.

Interface Module

Module which controls and extends the hardware periphery.

IRQ
Acronym for interrupt request. One of a set of possible hardware interrupts,
identified by a number. The number of the IRQ determines which interrupt handler
will be used. In the AT bus, ISA, and EISA, 15 IRQs are available. Each device’s
IRQ is hardwired or set by a jumper or DIP switch.

ISA

Industrial Standard Architecture (bus for expansion modules)
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J

JEIDA
Japanese Electronics Industry Development Association. Association of Japanese
electronics manufacturers whose aim is to set up standards worldwide for the
miniaturization and flexible application of PC expansion cards. Cooperates with
PCMCIA.

K

Keyboard
A keyboard is the collection of keys which are used to input data, text, characters,
letters, numbers, special characters, and control commands in a computer. The
keyboard forms the input interface between the user and the computer.

L

LCD
Liquid Crystal Display. Display type on the base of liquid crystals with a thin film
polarized molecular structure, enclosed between two transparent electrodes.

LED
Light Emitting Diode (for example, status display). Semiconductor diode that
transforms electrical energy into light.

Lid Switch
The device is switched off by closing the display lid.

LPT1 Port
The LPT1 port (Centronics port) is a parallel interface that can be used to connect
a printer.

LS120-Drive
Floppy disk drive that is capable of storing 120 MB of data on a single 3.5-inch
floppy disk. LS-120 drives are also compatible with other floppy disk formats.

M

Main Memory

Glossary-10

Main memory is a RAM memory in the CPU that is accessed by the CPU during
user program processing.
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Memory Card

Memory Cards in credit card format. memory for user programs and parameters,
for example, for programmable modules and CPs.

Micro Memory Card

New and very compact card for SIMATIC.

Memory Expansion

See Extended Memory

Modem

Communications device that enables a computer to send and receive data over a
telephone line. Modulator and dem odulator of a signal transmission facility. It
converts the digital pulses from a computer into analog signals (and vice versa).

Module

Modules are boards (printed circuit boards) which can be plugged into a
programmable logic controller or programming device. They are available, for
instance, as central controller modules, interface modules, or as bulk memory
modules.

Monitor

The device on which images generated by the computer’s video adapter are
displayed.

Mother Board

The mother board is the core of the programming device. From here data are
processed and stored, interfaces and device 1/Os are controlled and managed.

Mouse

The mouse is a pointing device with which the user inputs coordinates (x,y). By
moving the mouse, the mouse pointer can be moved at will around the screen. By
pressing the left mouse button, the position is marked. The other mouse keys may
have different assignments according to the application. With the mouse, objects
can be selected, menus processed, and functions started.

Mouse Pointer

The mouse pointer is moved across the worktop (screen) by means of the mouse.
The mouse pointer selects, for example, objects which are to be processed.
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MPI/DP
The multipoint interface (MPI) is the programming device interface for SIMATIC
S7. It offers simultaneous operation from one central station of several
programming devices, text displays, and operator panels. The stations on the MPI
can communicate with each other.

MS-DOS
The single Microsoft-Disk-Operating-System is one of the standard OS for PCs.

Multimedia
The combination of sound, graphics, animation, and video. In the world of
computers, multimedia is a subset of hypermedia, which combines the
aforementioned elements with hypertext.

N

Network
Link between programming devices and programmable controllers by means of
interface modules, physical cables, and the corresponding software to allow data
exchange between the devices.

@)

Operating System

Collective term for all functions which, in conjunction with the hardware, control
and monitor execution of the user programs, the distribution of resources among
the individual user programs, and the maintenance of the operating mode (for
example, Windows 98, MS-DOS).

P

Parallel Interface

Information is transmitted byte for byte via a parallel interface (port). This means
that the transmission rate is very fast. The programming devices have one parallel
interface (LPT1).

Password

Unique sequence of characters that is entered for user identification. See Access
Protection.
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PC

PC Card

PCI

PCMCIA

PG

PG LINK

Pixel

PLC

Personal computer

Trademark of the Personal Computer Memory Card International Association
(PCMCIA). Designation for auxiliary cards that conform with PCMCIA
specifications. The PC Card that has roughly the size of a credit card can be
plugged into a PCMCIA slot. Version 1 specifies cards of Type | with a thickness of
3.3 millimeters, which is conceived mainly for use as external memory. Version 2 of
the PCMCIA specification also defines a card Type Il with thickness of 5 mm and a
card of the Type Ill with a thickness of 10.5 mm. Type Il cards can realize devices
such as modems, fax and network interface cards. Type Il cards are equipped
with devices that require more space, for example wireless communication
modules or rotary storage media (hard disk drives, for example).

Peripheral Component Interconnect (high-speed 1/0O expansion bus)

(Personal Computer Memory Card International Association). Association of about
450 computer companies with the aim of setting worldwide standards for
miniaturizing PC expansion cards and making their use more flexible, offering the
market a basis for development. Cooperates with JEIDA.

See Cardbus interface.

Compact programming device especially for industrial applications. The PG is fully
equipped for programming SIMATIC PLCs.

Serial interface on a CPU, CP/IP module and coordination module (PG-MUX).
Used to connect a programming device. Some CPUs are optionally equipped with
two PG links.

Pix Element (picture point). The pixel represents the smallest element that can be
reproduced on-screen or on a printer.

SIMATIC S5 programmable logic controller
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Plug and Play

Generally, a reference to the ability of a computer to automatically configure the
system for communication with peripheral devices (for example monitors, modems
or printers). The user can plug in a peripheral and "play” it at once without
manually configuring the system. The Plug and Play PC requires both a BIOS that
supports Plug and Play and a corresponding expansion card.

Power Button

The device can be switched on or off with the power button.

Power Management

The Power Management of a modern PC can regulate the consumption of energy
of the most important components of the computer (e.g. monitor, hard disk and
CPU) individually, while the current active operations will not be affected. This
function is particularly important for portable computers.

PROFIBUS

Bus system based on the PROFIBUS standard. Components of the SIMATIC S5
and S7 series (programming devices, programmable logic controllers,
programmable control systems, distributed 1/0s) can be networked using
PROFIBUS.

Programmable Logic Controller System

The programmable logic controllers (PLC) of the SIMATIC S5 system consist of
one or more CPUs and various 1/0O modules. The PLCs of the SIMATIC S7 system
(for example, S7-200, S7-300, S7-400) consist of one or more CPUs and various
I/O modules.

Programmable Controller (AS)

This programmable controller (PLC) consists of the central unit, a CPU and of
diverse 1/0 modules.

Pull-Down Menu

See Drop-Down Menu

RAM

RAM (Random Access Memory) is a volatile read/write memory in which every
memory location can be addressed individually and its contents changed. RAM is
used to store data and programs.
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Rechargeable Battery

Reachargeable battery is used as a power source for laptop and notebook
computers independent of external power supply. It also prevents the loss of data
as a result of power failure.

Restart

Warm start of a computer in operate state without switching off the power supply
(Ctrl + Alt + Del).

ROM

ROM (Read Only Memory) is a hon-volatile memory in which every memory
location can be addressed individually. They contain factory set programs and data
that are not lost in the event of a power failure.

RS-232 Interface

The RS-232 interface is a standardized interface for data transmission. Printers,
modems and other hardware modules can be connected to a RS-232 interface.

RTC
Real Time Clock

S

SCSI Interface

Small Computer System Interface. Interface for connecting SCSI devices (hard
disk drives, CD-ROM drives).

Serial Interface

Data is transmitted one bit at a time via a serial interface (port); serial interfaces
are therefore slower than parallel interfaces.

Serial Ports Adaptors D9/D25

This adapter is used to convert the COM1/V24/PLC interface of the SIMATIC PC
family to a common socket.

SETUP

A program in which information about the device configuration (that is, the
configuration of the hardware on the programming device) is defined. The device
configuration of the programming device is preset with defaults. Changes must
therefore be entered in the SETUP if a memory extension, new modules, or a new
drive are added to the hardware configuration.
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SIMATIC S5 Memory Submodules

Memory submodules for SIMATIC S5 which are programmed with the PG and can
be plugged into an S5 programmable logic controller.

SIMATIC Memory Cards

Memory submodules in credit-card format for SIMATIC S5 and SIMATIC S7 which
are programmed with the PG and can be plugged into an S5 or S7 programmable
logic controller.

Software
The collective term for all programs which are used on a computer. The operating
system and the user programs are part of the concept “software”.

SOM
Safecard On Motherboard. Consists of a monitoring module on the motherboard,
the driver and the SOM program. Provides functions for monitoring various
temperatures and the program cycle (Watchdog).

Standby

Power saving status: for example, hard disk drive or display turned off.

Startup Disk

The bootstrap instructions coded into a computer’s ROM (read—only memory) and
executed at startup. The startup ROM routines enable a computer to check itself
and its devices (such as the keyboard and disk drives), prepare itself for operation,
and run a short program to load an operating—system loader program.

STEP 5
This is a software package which represents the basis for all other STEP 5
software packages. With the programming device (PG), this package is used to
program programmable logic controllers of the SIMATIC S5 family. The language
used is known as STEP 5.
STEP 7
Programming software for the creation of user programs for SIMATIC S7 control.
STN Display

Super Twist Nematic passive display
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Suspend to Disk

Transition to power-off status, with prior saving of the system contents to the hard
disk drive.

Suspend to RAM

SVGA

T

Text Cursor

TFT

Touchpad

Transition to power-saving status, with prior saving of the system contents to the
RAM.

Super Video Graphics Array is a video standard established by the Video
Electronics Standards Association (VESA) in 1989 to provide high-resolution color
display on IBM-compatible computers.

The cursor shows where text may be entered, for example, in text editors and in
dialog windows. In many applications the position of the cursor can be changed by
moving and clicking with the mouse pointer.

Thin-Film-Transistor. Technology for liquid crystal displays (LCD). The display
consists of a large grid of LCD cells. Each one of the pixels represents a single
cell. The electrical field in the cells is supported by thin film transistors.

The Touchpad is used in many programs (with mouse control) as an input device
for cursor control and menu operation. The Touchpad works with touch-sensitive
sensors. The cursor can be moved over the screen with the touch of a finger.

Touchscreen

The Touchscreen is a computer monitor developed and modified to recognize a
touch on the screen surface. The user can move the cursor or select an option by
touching the screen.
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URL

uUSB

Uniform Resource Locator is an address for a resource on the Internet. URLs are
used by Web browsers to locate Internet resources. A URL specifies the protocol
to be used in accessing the resource (such as http: for a World Wide Web page or
ftp: for an FTP site), the name of the server on which the resource resides (such
as /l'www.whitehouse.gov), and, optionally, the path to a resource (such as an
HTML document or a file on that server).

Acronym for universal serial bus. A serial bus with a data transfer rate of

12 megabits per second (Mbps) for connecting peripherals to a microcomputer.
USB can connect up to 127 peripherals, such as external CD-ROM drives,
printers, modems, mice, and keyboards, to the system through a single,
general-purpose port. This is accomplished by daisy chaining peripherals together.
USB is designed to support the ability to automatically add and configure new
devices and the ability to add such devices without having to shut down and restart
the system (hot plugging).

User Interface

The software-controlled menus and screens on the monitor through which the user
communicates with the program.

User program

VGA

Contains all instructions, declarations and signal processing data that can be used
for system or a process control. It is assigned to a programmable module (for
example, CPU, FM) and can be split into smaller blocks (modules).

Video Graphics Array. Industrial standard graphics adapter for use with any
commonly used software.

Video Adapter

Glossary-18

Also known as Video Controller, this electronic component generates the video
signal sent through a cable to a video display. The video adapter is usually located
on the computer’s main system board or on an expansion board, but it is
sometimes built into the terminal.
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W

Warm Start

WAV

Windows

WWW

Restart of a computer in operate state without switching off the power supply (Ctrl
+ Alt + Del).

A file format in which Windows stores sounds as waveforms. Such files have the
extension .wawv.

Windows is a multitasking graphical user interface environment that runs on
MS-DOS-based computers (Windows 3x and Windows for Workgroups), and as a
self-contained operating system for desktop computers (Windows 9x),
workstations, (Windows NT Workstation, Windows 2000 Professional ), and
network servers (Windows NT Server, Windows NT Enterprise Edition, Windows
2000 Server, and Windows 2000 Advanced Server). Windows provides a standard
graphical interface based on drop-down menus, windowed regions on the screen,
and a pointing device such as a mouse.

World Wide Web is the total set of interlinked hypertext documents residing on
HTTP servers all around the world. Documents on the World Wide Web, called
pages or Web pages, are written in HTML (Hypertext Markup Language), identified
by URLs (Uniform Resource Locators) that specify the particular machine and
pathname by which a file can be accessed, and transmitted from server to end
user under HTTP (Hypertext Transfer Protocol).

Working Memory

The memory in which a program is stored which can be processed. Also known as
main memory.

Write Protection

W2k

Write protection for files or diskettes

» Write protection for files; this type of write protection is stored in the computer
and is allocated by the system manager.

» Floppy disk write protection; for 3 1/2 in. diskettes by opening the write
protection hole.

Another name for Windows 2000.
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Battery compartment, 2-10
BIOS, 5-2 F
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BIOS Setup
Boot Menu, 5-24
built—in the type of disk drive, 5-6 G
date, 5-6

Exit menu, 5-27 Guide pins, 2-10
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Version menu, 5-26

BIOS-Setup, Memory Cache, 5-8 H
Hard Disk Drive, 2-22

Hardware Information, 7-1
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Cardbus, 3-16

Cold start, 3-5 I

Commissioning, 3-1, 3-5 ID sticker, 2-10
Complete restart, 3-7 Infrared keyboard, 2-4, 2-9
Connecting Infrared sender, 2-4
external monitor, 3-8 Installing memory submodules, 4-5
headphone, 3-10 Interface
microphone, 3-10 MPI/DP, 3-18
mouse, 3-9 RJ45 Ethernet, 3-21
USB Devices, 3-9 Interface Pinout, 7-3

Connection, external power supply, 3-4
Cursor key, 2-12
K

Keyboard, 2-4, 2-9

D Adjustment feet, 2-2
Device configuration, 5-1, 5-2 USB cable, 2-3
Diskettes, 2-20 Keyboard identifier, 2-2
Display, 2-3 Keyboard signals, 2-2
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Keyboard status, 2-17
Keyboard transmission status, 2-2
Keyboard-LEDs, 2-4

L

Latches, 2-9

LEDs, 2-5

LPT 1, 7-7

LS120 Disk Drive, 2-21

M

Memory expansion, 4-4, 4-7
Micro Memory Cards, 3-14
Mouse buttons, 2-4, 2-9
MPI/DP Interface, 3-18

O
On/Off pushbutton, 2-18

P

Parallel port, 7-7
Patch Cords, 7-10
PC interface, 3-16
Pin assignment
COM1, 7-9
Ethernet, 7-6
headphone, 7-8
Micro-In, 7-8
MPI/DP, 7-5
USB, 7-3
VGA, 7-4

Index-2

Point-to-point connection, 3-17

Processor Upgrade, 4-6
PROFIBUS, 3-20

R

Restart, 3-6, 3-7
RJ45 Ethernet Interface

S

, 3-21

S5 Memory Submodules, 3-11

Send window, 2-10
Setting up, 3-2
SETUP, 5-2

SIMATIC memory cards, 3-13
SIMATIC S7 Programmable Controller, 3-18

SIMATIC Software, 3-7
Special keys, 2-11

Status of the battery, 2-5
Stereo Loudspeaker, 2-4

Superdisk, 2-21
Switching on, 3-5
System startup, 3-6
System-LEDs, 2-5

T
Touchpad, 2-4, 2-9

Type of disk drive, built—in, 5-6

U

Unpacking, 3-2
USB cable, 2-10
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